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ABOUT THIS COURSE 

COURSE PREREQUISITES 

Before beginning this course, students should be comfortable using the keyboard and 
mouse. No previous experience with other versions of Windows is necessary, although it 
may be helpful. 
 

COURSE OVERVIEW  

This booklet may be used as either a self-contained course in Windows 10 or a user’s 
reference manual to find out specific areas or functions of Windows.   
 

COURSE OBJECTIVES 

By the end of this Part 1 course, users should be comfortable logging into Windows 10, 
completing basic actions using its user interface, customizing the user interface, 
understanding its security features, and using both Microsoft Edge and File Explorer. 
 

HOW TO USE THIS BOOKLET 

This course is broken up into six lessons. Each lesson focuses on several key parts, each of 
which are broken down into easy-to-follow concepts.  Note that there are a series of e-
learning episodes that follow the sequence of this book that a learner could use for a visual 
explanation.  
There is also a collection of Exercise Files; if you wish to use these download the files to a 
convenient location. They will be referenced throughout this course and may support your 
learning experience. 
 

WINDOWS AS A SERVICE 

Microsoft has announced that this version of Windows will be the last numbered version 
that it will offer. Future improvements and changes will be released as regular operating 
system updates, rather than new versions. 
 
Because of this, your version of Windows may not be exactly the same as the images shown 
in this manual. As well, some steps may be slightly different than what we have presented. 
 
This courseware was written with Build 10240 of Version 10. You can view your current 
version and build by press Win + R to open the Run dialog. Then, type, “winver” and click 
OK. The resulting dialog will provide the desired information. 
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LESSON 1: 
GETTING TO KNOW PC’S AND 
THE WINDOWS 10 USER 
INTERFACE 

 
 
 

Lesson Objectives 
 

In this lesson you will learn how to: 

 Identify the components of a personal computer 

 Sign into Windows 10 

 Navigate the desktop  

 Explore the Start menu 
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TOPIC A: Identify Components 
of a Personal Computer 
 
Microsoft Windows 10 is the latest major Windows release from Microsoft.  
 
Topic Objectives 
In this topic, you will learn: 
 About personal computers  
 About computer hardware  
 About operating systems  
 About application software 

 

PERSONAL COMPUTERS 

Commonplace in just about every workplace and home today, personal computers (PC’s) 
are small computers that are intended to be used by an individual user. Sometimes referred 
to as workstations, personal computers can range widely in size and portability. While many 
workplaces use desktop PC’s, laptop and notebook PC’s are also common as they allow you 
to carry your computer with you wherever you go. 
 
A point of distinction that continues to this day is that a personal computer refers to a 
computer that runs Microsoft Windows. If it uses Apple OS X, then it is typically referred to 
as a Mac. While today both are very similar in architecture and operation, this was not 
always the case and people still tend to categorize computers into PC’s or Mac’s.  
 

HARDWARE 

The term hardware is used to refer to the various physical parts that make up a personal 
computer. This hardware is what the operating system and its applications use to run. A 
typical PC consists of a computer case, power supply, motherboard (which includes a 
processor, RAM, and graphics card), as well as a hard drive on which data is stored.  
 
While optical disk drives (CD/DVD/Blu-ray) are still common, they are slowly being phased 
out as Internet speeds increase, online storage becomes more common, and flash-based 
thumb drives increase in size.  
 
Also considered as hardware are any external devices that can be attached to a computer 
through various connectors. For example, most personal computers have a monitor, 
keyboard, and mouse attached connected to them. In the case of a laptop computer, these 
devices are built directly into the computer’s case.  
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OPERATING SYSTEM 

The operating system (OS) runs on your personal computer’s hardware and provides a user 
interface that you can use to interact with the computer itself and run application software. 
Additionally, an operating system manages your computer’s resources (memory, processing 
power, networking, etc.) so that you can utilize them much more easily than would 
otherwise be possible:  
 

 
 
There are several different operating systems that are available, including Microsoft 
Windows, Apple OS X, Linux, Solaris, and FreeBSD. In today’s business environment, you will 
typically find that Microsoft Windows is by far the most used operating system. This is 
followed distantly by Apple OS X and Linux. Other operating systems are used for more 
specialized purposes.  
 
It is important to note that the Microsoft Windows branding includes several different 
versions of the same operating system. For example, while this course focuses on Windows 
10, you may run into Windows 8, Windows 7, Windows Vista, and even Windows XP. 
However, as Windows 10 is designed to replace these versions, older versions of Windows 
will become less common. 
 

APPLICATION SOFTWARE 

While the operating system provides you with an interface to interact with your computer 
and its resources, application software is provided to help you complete a specific task. For 
example, word processing software such as Microsoft Word exists to help you compose, 
edit, or view documents.  
 
Occasionally, software may be bundled and sold as suites, which include several individual 
applications that can typically work with one another. Microsoft Office, for example, is a 
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productivity suite that includes programs to help you compose documents, presentations, 
spreadsheets, and much more.  
 
When application software is opened on your computer, it is separated from the operating 
system using a window. For example, if you open WordPad you will see that it appears in its 
own window on your desktop:  
 

 
 
This system allows you to run multiple applications at the same time without getting them 
confused. Additionally, it provides some separation between the operating system and the 
software that runs on it.  
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TOPIC B: Sign Into Windows 10 
 
Unless it has been preconfigured otherwise, the first task that you will need to do when you 
turn on a computer running Windows 10 is to sign into your Windows account. Over the 
course of this topic, you will learn about how your computer starts up, the parts of the Lock 
screen, and how to sign into Windows 10. 
 
Topic Objectives 
In this topic, you will learn: 
 About the boot process  
 About the Lock screen  
 About the Sign In screen  
 About the Ease of Access menu  
 About the Shut Down Options menu  
 About the password sign in process 

 

THE BOOT PROCESS 

Just like when you start the ignition of your car, a computer needs a few moments to start 
up completely. When you first turn on your computer, it will automatically enter the boot 
process. This process is handled by your computer’s BIOS (Basic Input/Output System). This 
is specialized software that is stored on your computer’s motherboard and is separate from 
the operating system. It is used to control basic computer functions like hardware 
configuration and the boot process.  
 
This boot process will begin by first checking that there are no problems with your 
computer’s hardware using POST (Power On Self-Test). If any errors are found, you will 
typically hear a beep followed by an error message displayed on your screen. If no errors are 
found (as is almost always the case), the boot process will continue. The BIOS will continue 
on and hand over the boot process to the boot manager that is used by the operating 
system. In the case of Windows 10, this is the Windows Boot Manager (BOOTMGR). This 
boot manager will then continue to load the operating system itself. This stage is 
represented by a loading screen which will eventually give way to the Lock screen. 
 
The speed of the boot process depends on the hardware that your computer uses. In some 
cases your computer might be so fast that you barely notice the boot process at all, but it 
still happens in the background.  
 

THE LOCK SCREEN 

Once your computer has completed the boot process, you will be greeted by the Lock 
screen. This screen will display some basic information about your computer when it is not 
in use. It consists of a background picture, as well as some basic information such as the 
date and time, network information, app status updates, and more:   
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To continue logging into your computer and move past the Lock screen, click anywhere on 
the screen or press any key on your keyboard. This will cause the Lock screen to roll up and 
reveal the Sign In screen. 
 

THE SIGN IN SCREEN 

Once you’ve arrived at the Sign In screen, you may choose which user you would like to log 
in with. (In this example, John Smith is the only available user account, so it is already 
selected.) After having chosen a user, type the password into the provided field and press 
Enter on your keyboard or click the small arrow button to sign in: 
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EASE OF ACCESS MENU 

Located in the lower right-hand corner of the Sign In screen, the Ease of Access button ( ) 
will display the Ease of Access menu. This menu includes several controls that you can use 
to adjust various accessibility options before you even sign in: 
 

 
For example, you can change the screen contrast, adjust the magnification, display an on-
screen keyboard, enable the Narrator feature, and much more.  
 

SHUT DOWN OPTIONS MENU 

Also located in the lower right-hand corner of the Sign In screen is the Shut Down button (
). Clicking this button provides you with options to shut down the computer, restart it, or 
put it in sleep mode to conserve power without having to turn it off completely:   
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PASSWORD SIGN IN 

To help protect the contents of your Windows account, you will typically need to enter a 
password in order to sign into it. You can do this by typing it into the Password text box on 
the Sign In screen and pressing Enter or clicking the accompanying arrow button:   
 

 
 

Alternative Passwords 
Aside from traditional alphanumeric passwords, Windows 10 also supports both PIN and 
picture passwords. PIN passwords are simple numeric passwords that can be used in place 
of a regular password. The idea behind this is that you can much more easily log into your 
Windows device using a numeric combination:  
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Note that if you have the PIN option enabled, the “Sign-in options” link will appear below 
the PIN field. Clicking this link allows you to log into your account using your standard 
password if you wish.  
 
Picture passwords are similar to a PIN in that they offer you a simplified way to log into your 
account. Instead of having to type in your password, you recreate mouse gestures on a 
picture that you previously set up. If you have configured picture passwords for your 
account, the Sign In screen will look substantially different:  
 

 
 
In order to log in, you need to recreate the gestures that you used when setting up the 
picture password. In this case, a circle was dragged around the runner, while angled lines 
were dragged along the tops of the cliffs:  
 

 
 
Once you successfully recreate these gestures, you will be logged into your account.  
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ACTIVITY 1-1 
Signing into Windows  
 
To get started with Windows 10, you would like to start up your computer and sign into 
your account. 
 

1.  To begin, turn on your computer if it isn’t on already.  

  

2.  Once the boot process is complete, the Lock screen will be displayed. Notice that it 
shows the current date and time. Additionally, your network connection will be 
indicated using an icon in the lower right-hand corner of the screen:  
 

 

  

3.  Press the Enter key on your keyboard to display the Sign In screen:  
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4.  Review this screen and click the Ease of Access button( ):  
 

 

  

5.  The Ease of Access menu will provide you with a variety of different accessibility 
options. For example, you can increase the contrast of your screen by clicking the 
High Contrast option:  
 

 
 
Note that the Narrator may begin automatically and audibly list the options on this 
menu.  

   

6.  Click the Network button ( ) 
 

 



[13] Microsoft Windows 10 – Part 1 

© All rights reserved.  13 of 311 
 

7.  The Networks pane will now be displayed on the right side-hand of your screen. It 
will list any networks that your computer might already be connected to: 
 

 

   

8.  Click anywhere inside the Sign In screen to close this pane. Click inside the 
Password text box and type your password. Press Enter:   
 

 

   

9.  You will now be logged into your computer using your Windows account:  
 

 
 

This exercise is now complete. 
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TOPIC C: Navigate the Desktop 
 
Once you have logged into Windows 10, you will be greeted with the desktop. This is where 
you will do most of your work in Windows; this is where software applications are displayed. 
Over the course of this topic, you will learn all about how to navigate through the desktop.  
 
Topic Objectives 
In this topic, you will learn: 
 About the desktop 
 About the taskbar  
 About the notification area  
 About tooltips  
 About context menus  
 About jump lists  
 About dialog boxes  
 About desktop icons  
 How to enable Tablet mode 

 

THE DESKTOP 

Rather than show the Start screen (which was a large component of Windows 8 and 
Windows 8.1), Windows 10 will automatically display your computer’s desktop: 
 

 
 
The Windows 10 desktop (1) is designed to be used just as you would your desk or table at 
work. Items can be arranged in any order, folders and files can be saved on the desktop, and 
most programs run in separate windows on the desktop. 
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The Recycle Bin icon (2) is located in the upper left-hand corner by default. Any files that are 
going to be erased from your computer are stored here until the bin is emptied. If there are 
deleted files in the Recycle Bin, the bin will appear full: 
 

 
 
The taskbar (3) will display any programs you currently have open or have pinned to it. 
Additionally, the taskbar now incorporates a search field:  
 

 
 

THE TASKBAR 

The taskbar is located along the bottom of your screen and incorporates the Start button, 
search field, and notification area. In between the search field and the notification area, all 
open or pinned programs and folders are displayed: 
 

 
 

By default, the taskbar includes pinned icons for Microsoft Edge, File Explorer, and the 
Windows Store. Additionally, you will see an icon that toggles Task View. By hovering your 
mouse cursor over a pinned icon, you will see a tooltip that displays the application name:  
 

 
 
When an application is opened, that application’s icon will appear to the right of any pinned 
icons:  
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If you notice that an application icon on the taskbar appears to be stacked, this indicates 
that two windows for this application are open. For example, here you can see that two 
WordPad windows are open:  
 

 
 
To see a thumbnail of what is being displayed in each window of an open application, hover 
your cursor over the icon of that application on the taskbar. For example, here are the 
thumbnails for two open WordPad windows:  
 

 
 

As you open and use more applications, new application icons will be added to the right of 
the last taskbar item. You can click and drag these icons (including those that are pinned) 
wherever you like. For example, if you wanted to put the File Explorer icon in the first (left-
most) position on the taskbar, you would click and drag the File Explorer icon to the left of 
the Microsoft Edge icon: 
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To customize the taskbar, right-click a blank area of it to display a context menu. Move your 
cursor over the Toolbars submenu and you will see a complete list of all the toolbars that 
can be shown (or hidden):  
 

 
 

The taskbar context menu also gives you access to other options. For example, you can 
modify the search field, organize the windows on your screen in a variety of different ways, 
and lock the taskbar so that no changes can accidentally be made to it.  
 
Clicking the Task Manager option will display the Task Manager window, while clicking the 
Properties option will give you access to more advanced taskbar options.  
 

THE NOTIFICATION AREA 

Located in the lower right-hand corner of your screen, the notification area displays a 
number of small icons that show the status of some computer functions and programs, as 
well as the system date and time:  
 

 
 
When you first log into Windows 10, there are a few services and background programs that 
start in order to provide extra functionality for the computer. For example, you will see 
icons that provide information about network connectivity, sound volume, and the Action 
Center. Certain icons (typically those that are related to programs) in the notification area 
will hide themselves in order to make more room on the taskbar. To view hidden items, click 
the “Show hidden items” button ( ):  
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Most icons in the notification area can be interacted with by clicking, double-clicking, or 
right-clicking on them.  
 
For example, if you click the time, you are shown a basic calendar as well as controls to 
access date and time options:  
 

 
 

TOOLTIPS 

If you are ever unsure of what an icon in the notification area or on your desktop is used for, 
you can hover your mouse cursor over that item to display a tooltip. This tooltip will 
typically display the name of the item, but sometimes it can include a description and other 
information.  
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For example, if you hover your cursor over an icon in the notification area, you will see a 
tooltip that describes its current state:  
 

 
 

CONTEXT MENUS 

Context menus appear when you right-click an item in Windows 10. This menu will provide 
you with options to work within the context of the item that was selected.  
 
For example, if you right-click the Recycle Bin on your desktop, you will see an option to 
empty it, pin it to the Start menu, and more:  
 

 
 

If you are trying to interact with an item in Windows but can’t, find the option that you are 
looking for, there’s a good chance it can be found in the context menu.  
 

JUMP LISTS 

A jump list appears when you right-click a program icon on the 
taskbar, or if you click and drag an icon off the taskbar in an 
upwards direction. For example, the jump list for the File 
Explorer icon looks like the image to the right: 

 
How the top portion of a jump list looks will depend upon what 
application it is for. In this case, there is a list of folders that 
have been pinned in File Explorer, as well as a list of folders that 
are frequently accessed. The lower portion of a jump list will 
consist of at least two options: a shortcut to open the 
application (File Explorer in this case) and a command to pin (or 
unpin) this application to the taskbar. If the application is 
already running, you will also see a command to close it and any 
of its open windows.  
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DIALOG BOXES 

While working with Windows 10, you may run into a dialog box. These are small graphical 
pop-ups that are used to provide you with information about a task that you are about to 
do, or want to do, as well as prompt you for a response. For example, if you choose to 
permanently delete a folder, a dialog box will be displayed that asks you to confirm this 
action:  
 

 
 

In this case clicking Yes will delete the folder, while clicking No will cancel the action and 
close the dialog box. However, you may run into dialog boxes that only include a single OK 
button, or buttons that complete unique actions. Clicking the Close button (X) in the upper 
right-hand corner of a dialog box has the same effect as clicking No or Cancel. If you do not 
see this button available, you must choose one of the buttons on the dialog box to continue.  
 

DESKTOP ICONS 

There are several different desktop icons that you might run across as you work with 
Windows 10. 

In the example to the left, you can see four icons. As 
you already know, the Recycle Bin (1) is a storage area 
for files or folders that are ready to be deleted.  
 
There is also a folder (2) called “New folder” that 
contains subfolders and data. (You can tell this 
because the icon of a folder in Windows 10 will 
change to reflect its content. For example, if there was 
a folder on your desktop with some pictures inside, 
you would see small thumbnail images of some of 
those pictures poking out of the folder.) 

 
The “Notes” icon is a file (3) that was created in Notepad (a very basic text editor) and saved 
on the desktop. This means that the file will always be there on the desktop until it is moved 
or deleted. 
 
Finally, the last icon is a shortcut (4) that is used to open Microsoft WordPad, a very simple 
word processor that is included with Windows 10. Shortcuts are direct links to files, folders, 
or (most often) applications. You can tell that this is a shortcut by the small arrow in the 
corner of the icon. 
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Clicking any of these icons will select it. Double-clicking an icon will open the file/folder or 
launch the application. Here we can see the contents of the “New folder” folder displayed in 
File Explorer after it was double-clicked:  
 

 
 

You can also right-click an icon to see contextual options based on that particular item. For 
example, when you right-click a file icon you will see options to cut it, copy it, rename it, and 
much more: 
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Icons can be moved one at a time around the desktop by clicking, dragging, and then 
releasing the icon at the desired location. Additionally, you can move files in and out of 
folders using this method.  
 
To move multiple icons all at once as a group, first click and drag a box around the icons in 
question to select them. You will see a blue area outlining where you have dragged; this 
means that the items are selected. Below, you can see that two desktop icons are about to 
be selected: 
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Upon releasing your mouse button, any icons within the selection area will now be selected. 
Now if you click and drag any of the selected icons, you can move all of them as a group: 
 

 
 

ENABLING TABLET MODE 

First introduced in Windows 8, the Start screen was a full-screen replacement for the Start 
menu, but with many more features and expanded customization capabilities. While this 
feature proved useful for those with touch-enabled devices, it was less useful for traditional 
PC users. While the default Start screen was done away with in Windows 10, it can be 
brought back by enabling Tablet mode.  
 
To enable Tablet mode, first click the Action Center icon in the notification area: 
 

 
 
The Action Center pane will open along the right-hand side of your screen. In the Action 
Center, click “Tablet mode:”  
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With Tablet mode enabled, your screen will change to incorporate the Start screen. 
Additionally, any traditional windowed applications will be replaced with full screen apps 
and access to the desktop will be removed: 
 

 
 
To disable Tablet mode, follow the same steps and deselect the “Tablet mode” option: 
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ACTIVITY 1-2 
Navigating the Desktop 
 
Now that you understand how to sign into your Windows 10 account, you would like to 
begin acquainting yourself with its interface. Specifically, you would like to practice 
navigating the desktop.  
 

1.  To begin, turn on your computer if it isn’t on already and log into your Windows 
account.  

  

2.  The desktop will now be displayed:  
 

 
 

(Your desktop may be slightly different from what is shown here. If so, that’s OK.) 

  

3.  Move your cursor over the File Explorer icon on the taskbar. A tooltip will be 
displayed:  
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4.  Click the File Explorer icon to display the File Explorer window on your desktop:  
 

 
 
(Note that the application’s taskbar icon is now underlined to indicate that it is 
open.) 

  

5.  Right-click the File Explorer icon. You will see a jump list. Click “Close window:”  
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6.  Right-click on a blank area of the desktop and click New → Folder: 
 

 

  

7.  A folder icon will appear on the desktop with the name selected. Press Enter to 
apply the default name (“New folder”): 
 

 

  

8.  It turns out that you do not need this folder, so click on this folder to select it. Then, 
use your mouse to drag this folder to the Recycle Bin:  
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9.  Release your mouse button to place the folder in the Recycle Bin. Note that the 
icon will change to indicate that it currently has items in it. Double-click it: 
 

 

   

10.  The Recycle Bin will now be open in File Explorer. You can see the “New folder” 
folder listed:  
 

 

   

11.  Click the Close button in the upper right-hand corner of the File Explorer window:  
 

 

   

12.  Right-click the Recycle Bin icon and click Empty 
Recycle Bin:  
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13.  A dialog box will be displayed that asks you to confirm your choice to delete the 
contents of the Recycle Bin permanently. Click Yes:  
 

 

  

14.  The Recycle Bin is now empty and its icon will have changed to reflect that state: 
 

 
 

This exercise is now complete. 
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TOPIC D: The Start Menu 
 
Windows 10 uses the Start menu’s as the primary gateway to everything your computer has 
to offer. All installed programs can be accessed here. As well, you can view different 
locations on your computer, access your computer’s settings, and more. Over the course of 
this topic, you will learn all about the Start menu.  
 
Topic Objectives 
In this topic, you will learn: 
 How to use the Start button  
 About the different parts that make up the Start menu  
 About regular tiles and live tiles  
 How to resize the Start menu  
 How to view all apps in the Start menu 

 

USING THE START BUTTON 

To view the Start menu, click the Start button in the lower left-hand corner of your screen:  
 

 
 

(Alternatively, you can open the Start menu by pressing the Windows key on your 
keyboard.) 
 
In addition to displaying the Start menu, the Start button provides you with quick access to 
many different Windows tools and settings. To view these options, right-click the Start 
button:  
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In addition to a variety of tools and utilities, you can also find options to sign out of your 
account and shut down your computer.   
 

ANATOMY OF THE START MENU 

The Windows 10 Start menu takes some concepts from the Start screen that were used in 
Windows 8 and incorporates them into the traditional Start menu that has been included in 
Windows since 1995:  
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For example, you will see that the right side of the Start menu is populated with tile groups. 
These tiles act just like shortcuts on the desktop in that clicking on them will open an 
associated app or software application. These tiles can be grouped or rearranged into 
categories to suit your own preferences and you can add your own tiles if you wish. 
However, keep in mind that each copy of Windows 10 includes the same set of basic tiles. 
As there are quite a few different tiles on the Start menu, a vertical scroll bar is provided so 
that you can see all the tiles that are available.  
 
In the top left-hand corner of the Start menu, you will see your user name and profile 
picture. Clicking on this item will provide you with options to change account settings, lock 
your account, and sign out of it entirely:  
 

 
 

Just below your user name, you will see a list of frequently used apps. The items that 
populate this list are added automatically. Although you cannot add items to it manually, 
you do have the ability to remove items. To do this, right-click an item and then click, “Don’t 
show in this list:” 
 

 
 
In the lower left-hand corner of the Start menu you will see a list of 
core commands:  
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Clicking the File Explorer entry will display File Explorer on your desktop. If you click the 
small arrow that is adjacent to this entry, you will see a jump list that includes pinned and 
frequently accessed locations:  
 

 
 
Clicking the Settings listing will display the Settings window:  
 

 
 
Clicking Power will provide you with options to temporarily 
suspend your computer by putting it to sleep, restarting it, or 
shutting it down entirely:  
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Clicking the “All apps” listing will turn the entire left side of the Start menu in an 
alphabetical list that displays every app and desktop application that has been installed on 
your computer: 
 

 
Finally, while it is not part of the Start menu per se, it is important to note that the search 
field on the taskbar will automatically become active when the Start menu is displayed. This 
means that if the Start menu is displayed, anything you type will automatically be entered 
into the search field. This system allows you to quickly find and open applications by typing 
their name and then pressing the Enter key without having to navigate through the Start 
menu at all.  
 

TILES 

Each tile in the Start menu represents an associated app or desktop application. Clicking on 
these tiles will open that application on your desktop. While there are many different tiles 
that represent many different apps shown here by default, it is important to remember that 
this section of the Start menu is entirely customizable. You can remove tiles, add tiles, 
categorize them into new or existing groups, and rename those groups.  
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Resize Tiles 
Tiles can come in four different sizes: small, medium, wide, and large. In the default 
configuration, most of the tiles use the medium size, but tiles that display information more 
often use the wide size. However, a tile can be resized to any of the above four sizes.  
 
To resize a tile, right-click on it and move your cursor over the Resize option. The Resize 
submenu lists all the available sizes and the current one will be denoted by a checkmark. 
Click a new size to apply it:  
 

 
 

Move Tiles 
Tiles can be moved around within their categories, as well as from one category to another. 
Just like when moving icons around on your desktop, tiles are moved using the click and 
drag method.  
 
For example, suppose that you wanted to move the News tile to a more prominent place at 
the top of the Start menu. To do this, you would click and hold down your mouse button on 
this tile and then drag it upwards:  
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As you are dragging this tile, any adjacent tiles will darken and automatically move to 
accommodate the News tile’s new location. Once your cursor has arrived at the new 
location, releasing your mouse button will place it there:  
 

 
 
Rename Sections 
To help keep things organized, tiles on the Start menu can be sorted into sections. By 
default there are two sections: “Life at a glance” and “Play and explore.” Both these and any 
other sections can be renamed by clicking on the section name and then typing into the 
provided text box:  
 

 
 

After renaming a section, press the Enter key to apply the new name:  
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Add New Sections 
To create a new tile section, click and drag a tile so that it appears above the title of an 
existing section. When you see a coloured bar, you are in the right position: 
 

 
Release your mouse button to create the new tile section and add the current tile to it. 
While this new tile section does not yet have a name, a placeholder name will appear. From 
there you can rename the section as normal:  
 

 
 
Remove Tiles 
Any tile that appears on the Start menu can be removed. To do this, right-click the tile in 
question and then click “Unpin from Start:” 
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The selected tile will then immediately be removed from the Start menu: 
 

 
 
If you wish, you can even remove all the tiles from your Start menu so that only the left side 
of the Start menu is displayed.  
 

LIVE TILES 

By default, many tiles are considered live tiles. These types of tiles show live and constantly 
updating information directly.  
 
For example, you can see the top headlines within the News tile, current weather conditions 
in the Weather tile, financial news in the Money tile, and your latest e-mail messages in the 
Mail tile: 
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To disable this feature for a specific tile, right-click it and click “Turn live tile off:”  
 

 
 

To re-enable this feature, click the “Turn live tile on” option instead.  
 

RESIZING THE START MENU 

While the contents of the Start menu can be modified, you can also change its dimensions. 
For example, if your PC uses a widescreen monitor you might want to increase the width of 
the Start menu, or you could increase the height of the Start menu so that you don’t have to 
scroll to see all the tiles that have been pinned to it.  
 
To resize the Start menu vertically, move your cursor to the top edge of the menu until you 
see it turn into a double-headed arrow. Next, drag upward to increase the size of the Start 
menu or downward to decrease it:  
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To resize the Start menu horizontally, move your cursor to the right-most edge of the menu 
until you see your cursor turn into a double-headed arrow. Next, drag to the right to 
increase the width of the menu or to the left to decrease it:  
 

 
 
Note that when you resize the Start menu horizontally, you are only able to do it in 
increments that equal the width of all the tiles in a particular section. This means that if the 
Start menu includes two sections, you can have the two sections appear adjacent to each 
other to have a wider menu, or above and below each other to have a taller, narrower 
menu.  
 

VIEWING ALL APPS 

To view a list of all the apps and applications that have been installed on your computer, 
click the “All apps” option in the lower left-hand corner of the Start menu:  
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Now, the list of apps will be displayed and organized alphabetically:  
 

 
 
Clicking on an entry listed here will launch the associated app, while right-clicking on an 
entry will give you options to pin this app to the Start menu or to the taskbar:  
 

 
 

To return the Start menu back to its default state, click the Back button:  
 

 
 

Summary 
Over the course of this topic you were introduced to the concept of PC’s and how they 
operate. Additionally, you should now be comfortable completing very basic tasks in 
Windows 10, including signing into your Windows 10 account, navigating the desktop, and 
using the Start menu.   
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LESSON 2: 
USING WINDOWS STORE APPS 
AND NAVIGATION FEATURES 

 
 
 

Lesson Objectives 
 

In this lesson you will learn how to: 

 Multitask with apps 

 Search your computer 

 View notifications 

 

In this lesson you will learn about: 

 Windows Store apps  

 Windows 10 navigation  
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TOPIC A: Multitask with Apps 
 
One of the core functionalities found in Windows 10 is the ability to multitask with apps. By 
being able to master this functionality, you will be able to work much more efficiently with 
multiple applications. Over the course of this topic, you will learn all about how to multitask 
with apps.  
 
Topic Objectives 
In this topic, you will learn: 
 How to switch between apps  
 About the Snap feature  
 How to use the Snap Assist feature 
 How to close an app 

 

SWITCHING BETWEEN APPS 

In Windows, you can interact with different windows and items as if you were moving 
objects around on the surface of a desk. For example, windows can overlap each other and 
can be stacked. If you have two or more open apps on your screen, you can switch back and 
forth between them by clicking on a portion of the window.  
 
In the image below, there are two open windows. Notice how the Microsoft Edge window 
has a thin blue border and overlaps the File Explorer window. Both of these things mean 
that the Microsoft Edge window is the currently the active window:  
 

 
 
When you have several windows open at once, 
clicking between windows (and sometimes moving 
them) becomes impractical. That’s why every 
window that is currently open on your desktop 
displays an associated icon on the taskbar with a 
blue underline. The active window will also have an 
icon that will appear shaded in compared to the others. 
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By clicking on a taskbar icon for another open app, you can switch to that app. You can also 
cycle through open apps by holding down the Alt button and pressing the Tab button. When 
you are at the desired window, release both keys to jump to it:  
 

 
 

THE SNAP FEATURE 

A very neat feature in Windows 10 is the ability to snap apps to either side of the screen or 
in any of its four corners. This allows you to keep an eye on one app while working with one 
or more other apps at the same time.  
 
To snap any open app to either the left or right side of your screen, drag the title bar to 
either the left or right edge of the screen until you see a ripple effect expand to outline half 
of the screen:  
 

 
 
Release your mouse button and the selected app will expand to fill in that half of the screen:  
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To snap an app to a corner, click and drag the title bar of the app in question to the 
appropriate corner of the screen:  
 

 
 
To unsnap an app, click and drag its title bar towards the center of the screen.  
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USING SNAP ASSIST 

When you snap an app to any area of your screen, the Snap Assist feature will automatically 
display thumbnails of any currently open apps in the empty adjacent space. In this example, 
as the Money app was snapped to the right side of the screen, Snap Assist is shown on the 
left:  
 

 
 

Clicking on any one of the thumbnails listed here will fill in the remaining space with the 
associated app. In this example, the Microsoft Edge thumbnail was selected: 
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CLOSING AN APP 

There are several different ways that you can close an open app. The most straightforward 
method is to click the Close button in the upper right-hand corner of each app:  
 

 
 

You can also right-click the title bar or taskbar icon of the app in question and click “Close 
window:”  
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ACTIVITY 2-1 
Multitasking with Apps 
 
As multitasking is an extremely useful feature, you would like to practice multitasking with 
apps.  
 

1.  To begin, log into your Windows 10 account.  

  

2.  Click the File Explorer icon on the taskbar to open this application:  
 

 

  

3.  Next, click the Start button and then click on the News tile:  
 

 



[50]  Microsoft Windows 10 – Part 1 

© All rights reserved.  50 of 311 
       

4.  The News app will now be displayed on the desktop:  
 

 

  

5.  You would like to snap 
the News app to the left 
side of your screen. 
Click and drag the title 
bar of the News app 
window to the far-left 
edge of your screen 
until you see a ripple 
effect:  
 

 

   

6.  Release your mouse 
button and the News 
app will now take up 
the left side of your 
screen:  
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7.  The Snap Assist feature is now shown on the right side of your screen. Click the File 
Explorer thumbnail:  
 

 

   

8.  The File Explorer window will now be snapped to the right side of your screen:  
 

 

   

9.  Close the News app by clicking the Close button in its upper right-hand corner:  
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10.  Although the News app is now closed, the File Explorer window will still be snapped 
to the right side of the screen. To unsnap this window, click and drag the title bar of 
this window towards the middle of the desktop:  
 

 

  

11.  File Explorer will now be displayed in the middle of your desktop:  
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12.  Right-click the File Explorer taskbar icon and click “Close window:”   
 

 

  

13.  Sign out of Windows 10 to complete this exercise. 
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TOPIC B: Search Your 
Computer 
 
Windows 10 now offers improved access to its search functions through the incorporation 
of the search box into the taskbar. The most notable change you will find, however, is that 
Microsoft Cortana has now been integrated with Windows search functionality. Over the 
course of this topic, you will learn all about the various ways that you can search your 
computer.  
 
Topic Objectives 
In this topic, you will learn: 
 About Cortana 
 How to set up Cortana and use its voice commands  
 How to use the search field  
 How to use the Cortana menu and the Cortana notebook 

 

GETTING TO KNOW CORTANA 

Microsoft Cortana is a digital assistant that was first created by Microsoft for Windows 
Phone. Its chief purpose is to facilitate the search functionality in Windows 10 through 
integration with the Bing search engine. It can also complete basic tasks for you such as 
setting reminders, scheduling appointments, and much more. Windows 10 marks the first 
time that that this powerful feature has made it to Windows on the PC.  
 
Cortana is special in a few different ways. One of these features is that it can function not 
only on text-based input, but also using natural voice commands. This means that you can 
interact with Cortana by simply talking to your computer and asking questions. For example, 
you could ask Cortana, “Will I need a coat tomorrow?” and Cortana will use its Bing 
integration to look up the weather for tomorrow and provide you with an audible answer – 
just like a natural conversation!  
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SETTING UP CORTANA 

Before you can start using Cortana, you first 
need to complete some simple configuration 
tasks to get it working properly. To do this, 
first click inside the search box on the 
taskbar. Some information about Cortana 
and what it is capable of will be displayed. 
Click Next:  

 
(If you do not wish to enable Cortana at this 
time, clicking the “Not interested” button will 
hide this information.) 
 
As Cortana collects your information and 
uses it with Microsoft operated services 
(such as Bing), you will need to agree to a 
privacy statement before continuing. Clicking 
the “I agree” button will continue the 
configuration process:  
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At this point you need to enter the name that you 
would like Cortana to refer to you as when 
responding to queries. Upon entering a name, click 
Next to continue: 

 
 
 

Next, you will be prompted to allow Cortana to use 
your location. For the best results, click Allow: 
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Click Yes to confirm this setting: 
 

 
 
At this point you can choose to have Cortana listen for the prompt “Hey Cortana.” By 
enabling this option, you don’t have to use the search box to interact with Cortana. All you 
will need to do is say, “Hey Cortana” followed by a query such as, “What’s the weather 
outside?” If you wish you enable this feature, click the “Yes please” button.” Otherwise, click 
“Not now:” 

 
 
If you choose to enable the “Hey Cortana” feature, you will then be asked to speak various 
phrases into your microphone so that it can learn to recognize your voice pattern. 
Otherwise, the configuration process will be complete.  
 

USING CORTANA VOICE COMMANDS 

There are hundreds of possible voice commands that you can use to interact with Cortana. 
For example, you can conduct mathematical operations (“What’s the square root of 42?”), 
set reminders (“At five o’clock, remind me to call Jane”), get directions (“Get me directions 
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to the nearest Starbucks.”), play music (“Play the Rolling Stones”), and even get it to tell 
jokes (“Tell me a joke”).  
 
If Cortana has been configured, you will see that the search box on the taskbar includes a 
small microphone button:  
 

 
 
If you click this button, Cortana will begin to listen for a voice command: 
 

 
 

(You can also toggle this feature by pressing Win + C on your 
keyboard.) 

 
As you speak a voice command, its interpretation of what 
you are saying will be printed in the search box. After a 
moment, a response will be presented both visually inside 
the Cortana menu and audibly. For example, here you can 
see Cortana responding to the query, “What’s the weather 
like at Halifax in Canada?” 
 

 
 

  



[59] Microsoft Windows 10 – Part 1 

© All rights reserved.  59 of 311 
 

The “Hey Cortana” Feature  
If you have chosen to enable the “Hey Cortana” feature, then you don’t need to use the 
microphone button to interact with Cortana. At any point that you require Cortana’s 
assistance, just say “Hey Cortana” followed immediately by your command. For example, if 
you wanted to know the weather you would say, “Hey Cortana, what’s the weather like 
outside?”  
 
A smaller version of the Cortana menu will appear and the question “what’s the weather 
like outside” will be displayed inside the search box:  
 

 
 

The results of this command will then be displayed visually and audibly in the Cortana menu 
as before. 
 
Secondary Commands 
Occasionally a command will require secondary 
information. For example, suppose that you wanted 
Cortana to set a reminder for you and you say, “At 
five o’clock remind me to call Jane.” Cortana will 
process this information and then give you a chance 
to confirm it (“Yes”), repeat the command (“No”), or 
cancel the whole process (“Cancel”): 

 
(Rather than having to repeat yourself, you can also 
adjust the reminder manually in the Cortana menu 
using the various items outlined in blue.) 
 
Search Using Bing  
As Cortana is fully integrated with the Bing web 
search engine, you can use Cortana to search the 
web. For example, suppose that you wanted to 
research the War of 1812. To do this, toggle Cortana 
and say “The War of 1812.” Following this 
command, Cortana will open the Microsoft Edge 
browser (or, if it is open already, a new tab will be 
created). The search results based on your query will 
be displayed:  
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USING THE SEARCH FIELD 

While Cortana can search your computer for 
specific files or folders (such as “Find the 
Welcome to PowerPoint presentation”), it 
can sometimes get confused when you have 
more complex file names like 
“3QTR_results_presentation.pptx.” In such 
situations, typing a query into the search 
field on the taskbar is often a smoother 
experience.  
 
To use the search field, click inside it and 
then type your query. The results will 
immediately be shown in the search menu:  
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The search menu is divided into two sections: 
 

 
 
The top part of the section will list the top results from the search (1). Typically this is 
where you will see what you are looking for. Below the top results section, the search menu 
will be divided into sections based on the results (2). For example, you will see suggested 
web searches, items that can be found in the Control Panel, any apps or applications that 
you might have installed, as well as items in the Windows Store. 
 
(As the top result in a search will already be selected, pressing Enter on your keyboard will 
automatically open that result after conducting a search.) 
 
At the bottom of the search menu after you conduct a search, you will also see two buttons: 
“My stuff” and Web. 
 

 
 
Clicking the “My stuff” button will display only results from your computer and ignore 
results from the web. Additionally, it will display an expanded search tool. This will include 
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much more detailed information about the results of the search, as well as tools to sort 
those results:  
 

 
 

On the other hand, if you click the Web button, then the results of a Bing web search using 
those terms will be displayed in the Microsoft Edge browser:  
 

 
 

USING THE CORTANA MENU 

When you first click inside the search box, the Cortana menu will display the home page. By 
default, this includes basic information such as the current weather conditions in your area, 
recent news headlines, and anything your might have on your schedule. However, keep in 
mind that all of this is completely customizable.  
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On the left-hand side, you will see a stack of icons that can display different 
areas of the Cortana menu:  
 

 
Clicking the hamburger icon ( ) at the top will expand the menu to show the 
names of each option:  
 

 
 
The Notebook button will display the Cortana Notebook. 
This is where you can customize how Cortana operates 
in a variety of different ways. For example, you can 
choose what categories of information you would like to 
include on the home page of the Cortana menu:  
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Clicking the Reminders button will display the Reminders list. 
This is where any reminders that you scheduled through 
Cortana will be listed. Using the controls here, you can 
remove, modify, sort, and add reminders:  
 
Finally, the Feedback button provides you with the 
opportunity to provide feedback to Microsoft about Cortana 
and how it performs: 
 

 
 

USING THE CORTANA NOTEBOOK  

Cortana’s Notebook is where you can access some of 
the settings that control Cortana and choose what kind 
of information you would like Cortana to display on its 
home page.  
 
With the Notebook button selected on the Cortana 
menu, you will see that it is divided into two sections:  
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The top section includes the following options:  
 

 
 
Let’s look at each option in detail. 
 
About Me: Clicking this option will give you access to controls to change the name that 
Cortana uses for queries, as well as how it pronounces it. 

 

 
 

Additionally, you can add, edit, or remove favorite places. This is useful if you are frequently 
asking for directions, since it is easier to say “Where is the closest Coffee Club to work?” 
than “Where is the closest Coffee Club to 4867 Complicated Drive?”  

 
Connected Accounts: If you are using an Office 365 account to log into your Windows 10 
account, Cortana offers an expanded feature set. 
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Settings: This is where you will find most of the settings 
that control how Cortana works – on the right. 
 

 
The first switch at the top of the menu will allow you to 
turn Cortana off entirely. Additionally, you will find a link 
that allows you to see and manage what Cortana knows 
about you. This is typically information like search 
history, interests, saved places, and other items (as 
shown below): 
 

 
 
The second switch from the top, Hey Cortana, allows you to toggle the “Hey Cortana” 
feature on or off. Remember, this allows you to say “Hey Cortana” followed by a command 
or query without having to interact with Cortana in any other way. Additionally, you can 
choose to have Cortana respond best to just you or whomever happens to be using the 
computer. If you choose the former option, Cortana will then need to learn your voice by 
having you read a number of different statements:  
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Lower in the Settings menu, you will find a toggle (“Find flights and more”) to control how 
Cortana automatically finds tracking information, such as flight numbers in any messages 
that you receive. It can then use that information to provide you with up-to-date 
information.  
 
Additionally, you will also find a toggle (“Taskbar tidbits”) that controls whether or not 
Cortana can issue you greetings or other information inside the search box, but not audibly:  
 

 
 

Below the toggles and buttons, you will find links that allow you to directly access Bing 
SafeSearch settings to filter the content that can be returned from a Cortana search, as well 
as modify other privacy settings and learn more about Cortana and search in Windows 10.  
 
Showing and Hiding Categories 
Cortana’s home page can provide you with all sorts of 
information. For example, you can display sports scores, 
recent news, recipe suggestions, and much more. 
Additionally, the more Cortana knows about your likes 
and dislikes, the better it can provide results that are 
more tailored to you.  
 
To customize what categories of information are shown 
on the Cortana home page, refer to the second half of the 
Settings menu (as shown on the right): 

 
Clicking on a category will show contextual options that 
allow you to tailor the category to your needs. For 
example, if you click the News option, you will see a toggle 
at the top of the menu that gives you the options to turn 
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off news cards so that headlines are removed from the Cortana home page entirely: 
 

 
 

Below that primary toggle, you can choose to add or remove local news, headline news, 
recommended stories, news category cards, and/or trending news:  
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Additionally, you can choose to give precedence to headlines that relate to a specified 
category or topic. For example, you can choose to follow only “Technology headlines” or 
something much more specific like “Pluto:” 
 

 
 
Any changes that you make to a category will immediately be represented on Cortana’s 
home page:  
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TOPIC C: View Notifications 
 
Notifications have been a component of Windows in one way or another for quite a while. 
While their core purpose (to alert you of events) is unchanged, they have been updated in 
different ways. Over the course of this topic you will learn all about notifications and how 
they have changed in Windows 10.  
 
Topic Objectives 
In this topic, you will learn: 
 About Windows 10 notifications  
 About the Action Center 
 How to open and close the Action Center  
 How to clear notifications  
 How to customize notification settings 

 

ABOUT WINDOWS 10 NOTIFICATIONS 

Notifications are a way in which apps and Windows 10 itself alert you of important events 
without directly interrupting whatever you’re working on.  
 
For example, if you insert a removable device into your computer, Windows 10 will show a 
notification in the lower right-hand corner of your screen:  
 

 
 
Notifications also act as a shortcut to address what is happening. For example, if you were 
to click on a notification about a removable device that has been connected to your PC, a 
menu of options will be provided in the upper right-hand corner of your screen: 
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Similarly, if you were to click on a notification that was displayed because you received a 
new e-mail message, the message in question will be opened in the Mail app.  
 
Notifications can be useful to let you know what’s going on. However, there may be 
instances where they don’t need any action from you. While they will automatically be 
hidden from view after a few seconds, you can choose to disregard a notification entirely by 
moving your mouse over the notification and clicking the small X button in its upper right-
hand corner:  
 

 
 

ABOUT THE ACTION CENTER 

The Action Center has been completely reorganized in Windows 10 and its purpose has also 
changed somewhat. While it is still an area where you can view security and maintenance 
notifications, it also acts as a central hub where you can view and interact with notifications 
from apps of all kinds. Additionally, it has been designed to provide you with quick access to 
a number of the more frequently used Windows 10 settings.  
 
Instead of appearing in a window, the Action Center appears as a task pane on the right 
hand-side of your screen:  
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The top three quarters of the Action Center lists notifications and organizes them by app 
(Tips, Money, etc.) or category (such as Security and Maintenance). You can interact with 
these notifications in the same manner as you would if they appeared on your screen. For 
example, clicking on a notification will allow you to address it or view its associated content.  
 
The lower quarter of the Action Center includes a grid of quick actions. By default, these 
quick actions include a “Tablet mode” toggle button and a rotation lock toggle for tablets. 
You will also find links to the Settings window, the OneNote notes feature, VPN connection 
information, device connection information, and toggle buttons for Location and Quiet 
Hours features (which both silence notifications).  
Clicking a quick action button will toggle a setting (such as Quiet Hours or Tablet mode), 
display a window (such as All Settings or Notes), or display settings directly within the task 
pane (such as Connect).  
 

OPENING AND CLOSING THE ACTION CENTER 

In the notification area, you will see the Action Center taskbar icon:  
 

 
 
This taskbar icon will change slightly depending on if there are new notifications available in 
the Action Center: 
 

 
 
If there are no new notifications, then the icon will have no fill:  
 

 
 
If you have enabled the Quiet Hours feature so that you are not bothered by new 
notifications, the icon will look like this:  
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No matter what the state of the Action Center icon is, clicking on it will display the Action 
Center task pane:  
 

 
When you are done with the Action Center, click on another area of your screen or the 
Action Center icon in the notification area to close it. 
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CLEARING NOTIFICATIONS 

As the Action Center acts as a hub for any and all notifications, it can sometimes become a 
little cluttered. To help keep things neat, you have the option to clear individual, categories 
of, or all notifications. To clear an individual notification, click the small X button in its top 
right-hand corner:  
 

 
 

To clear all of the notifications from a specific app or category, first move your mouse 
cursor over the app or category header. This action will display an X button. When this 
button is clicked, it will clear all of the notifications in the associated app or category:  
 

 
 
Finally, to clear all of the notifications within the Action Center, click the “Clear all” link in 
its upper right-hand corner:  
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If the notifications have been cleared from the Action Center, only a simple message will be 
displayed in addition to the quick action buttons:  
 

 
 

CUSTOMIZING NOTIFICATION SETTINGS 

Like many of the components that make up Windows 10, the Action Center and the 
notification settings can be modified in different ways. To customize these settings, first 
display the Settings window by clicking “All settings” in the Action Center:  
 

 
 
Then, click the System category: 
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With the System category displayed, choose the “Notifications & actions” sub-category. All 
settings to customize notifications and the Action Center will be listed here: 
 

 
 

Let’s examine the settings that are available in this category by section:  
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In the “Quick actions” section, the four small buttons are used to select the four primary 
quick actions that you would like to have displayed on the Action Center. For example, you 
could swap out the “Tablet mode” button for the VPN toggle if you wanted. However, the 
available actions will be shown by default if the action buttons area in the Action Center is 
expanded.  
Below these buttons are links to choose exactly what is shown in the notification area. For 
example, you could choose to hide the volume control icon or an icon from a third-party 
program. 
 
The Notifications section includes toggles that allow you to choose what kind of 
notifications are displayed and when: 
 

 
 

By default you will see notifications that include tips and app notifications. Additionally, you 
can choose to have notifications shown on the Lock screen, as well as alarms, reminders, 
and incoming VOIP calls. If you wish, you can also choose to have all notifications hidden 
while you are presenting in PowerPoint or another application.  
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The “Show notifications from these apps” section is where you can turn on or off 
notifications on an app-by-app basis: 
 

 
 

For example, if you wanted to prevent the News app from displaying notifications, you 
would toggle its associated control to the Off position.  
 

ACTIVITY 2-1 
Viewing and Managing Notifications  
 
You have noticed that you have received a few different notifications over the past few days 
since you started using Windows 10. You would like to use the Action Center to view and 
manage these notifications.  
 

1.  To begin, log into your Windows 10 account.  

  

2.  Examine the notification area on the far right-hand side of the taskbar. Click the 
Action Center icon:  
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3.  The Action Center task pane will now be displayed on the right-hand side of your 
screen. The upper portion of the task pane will be populated with notifications, 
while the lower portion will display quick actions:  
 

 

  

4.  Review the list of notifications. Beside any notification, click the downward 
pointing arrow in its lower right-hand corner to expand it:  
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5.  Review this notification. When you are done with it, clear it by clicking the X button 
in its upper right-hand corner:  
 

 

   

6.  The selected notification will now have been cleared from the Action Center. Next, 
you would like to clear all of the notifications that you see here. In the upper right-
hand corner of the Action Center, click the “Clear all” link:  
 

 
 

(If you do not have any notifications, skip to step eight.) 

   

7.  All of the notifications that were listed in the Action Center will now have been 
cleared:  
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8.  To make room for more notifications, you would like to only show the top row of 
action buttons at the bottom of the task pane. Near the lower right-hand corner of 
the Action Center, click the Collapse button:  
 

 

   

9.  The Action Center will now look like this:  
 

 

  

10.  Click anywhere outside of the Action Center to close it. Log out of your Windows 10 
account to complete this exercise.  
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TOPIC D: Windows Store Apps 
 
The Windows Store lets you search through a wide variety of apps that have been created 
by third-party developers. Once you have found an app that you like, you can then choose 
to purchase, download, and install it to your PC. These apps range from games to 
productivity software, with a wide selection that is available for free. In this topic, you will 
learn how to use the Windows Store to find and download new apps. 
 
Topic Objectives 
In this topic, you will learn: 
 About Windows Store apps  
 How to open the Windows Store  
 How to navigate through the Windows Store  
 How to download and install apps from the Windows Store 
 How to uninstall apps downloaded from the Windows Store 

 

ABOUT THE WINDOWS STORE 

The Windows Store is a central hub where you can find, download, and install new apps, all 
from one central location. This saves you from trying to track down apps from various places 
on the Internet and provides a much simpler way to install them. Additionally, the Windows 
Store allows you to download games, music, and even television episodes and movies.  
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OPENING THE WINDOWS STORE 

To open the Windows Store, click the Store tile on the Start menu:  
 

 
 
(You may need to scroll down a little bit to see this tile.) 
 
You can also type “Store” inside the search box and click on the top result: 
 

 
 
Or, simply click the Store icon on the taskbar:  
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No matter which way you open the Windows Store, it will appear on the desktop in its own 
window:  
 

 
 

COMMON WINDOWS STORE APP NAVIGATION FEATURES 

At the time of publication, there were hundreds of thousands of apps available in the 
Windows Store, and even more music, movies, and games. Luckily the Windows Store has 
several different features to make navigation easier: 
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When you first open the Windows Store, you will see some popular downloads (apps, 
games, movies, etc.) featured prominently in the carousel gallery (1). Above this you will 
see five main categories: Home, Apps, Games, Music, and Movies & TV (2). You can click 
any category to view related results:  
 

 
 
Near the top right-hand corner of the Windows Store, you will see the Search field (3). Using 
this feature you can enter keywords to find the item you are looking for across all of the 
categories. For example, here we were looking for PowerPoint: 
 

 
 
(Clicking on any result listed here will display the associated product page.)  
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Finally, if you scroll down with any of the categories displayed, you will see many different 
general categories (4) that can help you find the download that you want. For example, the 
Home category will show lists for the most popular free apps, the most popular paid apps, 
and apps that are the highest rated by other users:  
 

 
 

DOWNLOADING AND INSTALLING WINDOWS STORE APPS 

Once you have found the app that you are looking for, you can start to download and install 
it from its product page. The product page typically includes a description of the app, a 
selection of screenshots, user reviews, technical information, and a list of related apps. To 
download and install the app, click the Free button:  
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(If it is a paid app, you would see a price instead, and would be prompted to enter account 
and payment information upon clicking it.) 
 
A progress bar will then appear and indicate the download and installation process: 
 

 
 

When the process is done, the app is ready to be used and can be found through the Start 
menu. Additionally, an Open button will also be displayed on the product page:  
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UNINSTALLING APPS  

To uninstall an app, first display it in the Start menu or using the search field. Right-click the 
listing and click Uninstall:  
 

 
 

If you choose to use the search box, the app will immediately be uninstalled from your 
computer. If you choose instead to use the Start menu, a pop-up dialog will ask you to 
confirm your choice. Click Uninstall to complete the process:  
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ACTIVITY 2-2 
Working with Windows Store Apps 
 
You would like to add some apps to your computer from the Windows Store so that you can 
do more with your computer.  
 

1.  To begin, log into your Windows 10 account.  

  

2.  Open the Windows Store by typing “Store” into the search box on the taskbar and 
clicking the top result:  
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3.  The Windows Store will now be open in its own window on your desktop:  
 

 

  

4.  Near the top of the Store window, click the Apps category:  
 

 

  

5.  Scroll down and review all of the options that are presented in the Apps category:  
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6.  Near the top right-hand corner of the Store window, click inside the Search box. 
Type “Adobe Reader:”  
 

 

   

7.  Press the Enter key on your keyboard. You will see a list of apps in the Windows 
Store that match the terms that you entered. Click the Adobe Reader Touch option:  
 

 

  

8.  The product page for this app will now be displayed. Review its information and 
then click the Free button:  
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9.  After a few moments, the app will start to download and install. You can keep track 
of its progress by watching the progress bar just below the app description: 
 

 

   

10.  Once the download and installation process is completed, the Open button will be 
displayed. Click it:  
 

 

  

11.  The Adobe Reader Touch app will now be displayed in its own window. Close it by 
clicking the Close button in its upper right-hand corner: 
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12.  It turns out that you don’t need this app, so you would like to remove it. Click Start 
→ All apps:  
 

 

  

13.  Scroll through the list of apps in the Start menu. Right-click the listing for Adobe 
Reader Touch. Click Uninstall:  
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14.  A pop-up dialog will be displayed. Click Uninstall to complete the process: 
 

 

  

15.  The app will now have been uninstalled from your computer and you will no longer 
see it listed within “All apps” on the Start menu. Close the Store window and then 
sign out of your Windows 10 account to complete this exercise.  
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TOPIC E: Windows 10 
Navigation Summary 
 
One of the key things that you need to know to successfully use Windows 10 is how to 
navigate through it. Over the course of this topic you will learn about the various methods, 
gestures, and keyboard shortcuts that you can use to efficiently make your way around the 
Windows 10 interface.  
 
Topic Objectives 
In this topic, you will learn: 
 About moving between apps  
 How to complete basic navigation actions 
 How to modify the layout of desktop windows 

 

MOVING BETWEEN APPS 

Gestures and keyboard shortcuts continue to be a component of Windows, but a few things 
have changed.  
 
On the following pages, you will see several common tasks. Each task is followed by the 
different methods that you can use to complete it. 
 
Switch to a Recent Window 
Mouse Technique 
Move your cursor over an application icon on the taskbar to see a thumbnail of its open 
window:  
 
 

 
 
Click a thumbnail or the icon to switch to that application.  
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Keyboard Shortcut 
Alt + Tab 
 
Touchpad Gesture 

Swipe left or right with three 
fingers and scrub through the 
available apps. Remove your 
fingers from the touchpad to 
open the selected app. 
 

 
 
Display the Task View 
Mouse Technique 
Click the Task View button beside the search box on the taskbar: 
 

 
 
Keyboard Shortcut 
Win + Tab 
 
Touchpad Gesture 

With the desktop displayed, swipe 
up on the touchpad with three 
fingers. 
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Peek at the Desktop 
Mouse Technique 
Right-click the edge of the notification area and click “Peek at desktop:”  
 

 
 
Keyboard Shortcut 
Win + ,  
 
Touchpad Gesture 
None 
 
Minimize All Open Windows and Display the Desktop 
Mouse Technique 
Click the thin Show Desktop button at the far-right side of the taskbar:  
 

 
Keyboard Shortcut 
Win + D 
 
Touchpad Gesture 

Swipe down on the touchpad with 
three fingers. 

 
 
Re-Maximize All Windows Previously Minimized 
Mouse Technique 
Click the thin Show Desktop button at the far-right side of the taskbar:  
 

 
 

Keyboard Shortcut 
Win + D 
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Touchpad Gesture 

Swipe up on the touchpad with 
three fingers. 

 
 

BASIC ACTIONS 

Here is how to complete some basic actions with the Windows interface. 
 

Task Mouse Technique Keyboard Shortcut Touchpad Gesture 

Close a 
Window 

Click the X button in the upper 
right-hand corner of any open 
window:  
 

 

Alt + F4 None 

Maximize a 
Window 

Click the square Maximize 
button near the upper right-
hand corner of any open 
window:  
 

 

Win + Up Arrow None 

Minimize a 
Window 

Click the Minimize button near 
the upper right-hand corner of 
any open window:  
 

 

Win + Down Arrow None 

Scroll Up or 
Down/Left 
or Right 
 

Click the scrollbar buttons or 
drag the scrollbar into position. 
Alternatively, you can spin a 
scroll wheel if your mouse has 
one.  

Left, Right, Up, or 
Down Arrow keys 

None 
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Task Mouse Technique Keyboard Shortcut Touchpad Gesture 

Display the 
Start Menu 

In the lower left-hand corner 
of your screen, click the Start 
button:  
 

 

Win None 

Display the 
Search 
Menu 

Click inside the Search field:  
 

 

Win + S None 

Wake Up 
Cortana 
with 
Speech 
Recognition 

Click the microphone button 
on the right of the search box:  
 

 

Win + C None 

Display the 
Action 
Center 

Click the Action Center button 
in the notification area:  
 

 

Win + A Swipe from the right 
edge of the touchpad 
inwards. 
 

 
 

MODIFYING WINDOW LAYOUT 

Here is how to modify the layout of windows on your desktop. (Note that this subtopic 
discusses some features that have not been covered yet. These features will be covered 
later in this course.) 
 

Task Mouse Technique Keyboard Shortcut 

Snap an App 
(to the left or 
right side of 
your screen) 

Click and drag an open app window to the left or 
right edge of your screen until you see a ripple 
effect. Release your mouse button.  

Win + Left or Right 
Arrow 



[100]  Microsoft Windows 10 – Part 1 

© All rights reserved.  100 of 311 
       

Task Mouse Technique Keyboard Shortcut 

Snap an App 
(to one of the 
four corners of 
your screen) 

Click and drag an open app window to the corner 
of your screen until you see a ripple effect. 
Release your mouse button.  

None 

Unsnap an 
App 

Click and drag a snapped app towards the middle 
of your screen. Release your mouse button.  

Win + Up Arrow or 
Down Arrow 
multiple times 

Create a new 
Virtual 
Desktop 

Display the Task View and then click the New 
Desktop button:  

 

Win + Ctrl + D 

Close Current 
Virtual 
Desktop 

Display the Task View and then click the X button 
near the top right-hand corner of the virtual 
desktop in question: 

 

Win + Ctrl + F4 

Switch to a 
Virtual 
Desktop 

Display the Task View and then click the 
thumbnail of the virtual desktop in question: 

 

Win + Ctrl + 
Left/Right Arrow 
 

 

Summary 
Over the course of this lesson, you learned how to navigate through Windows 10 and how 
to use its powerful multitasking features. You should now be comfortable switching 
between apps, snapping apps, using Cortana, and viewing notifications. Additionally, you 
should be comfortable viewing the Action Center and using the Windows Store to find and 
download apps.  
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LESSON 3: 
WORKING WITH DESKTOP 
APPLICATIONS 

 
 
 

Lesson Objectives 
 

In this lesson you will learn how to: 

 Work with desktop windows 

 Manage files and folders with File Explorer 

 Create and modify files with desktop applications 
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TOPIC A: Work with Desktop 
Windows 
 
Working with desktop windows is a key skill when using Windows 10. By being able to 
manage windows on your desktop and switch between them easily, you can multitask 
between applications and be more productive than ever. Over the course of this topic, you 
will learn how to work with a desktop window.  
 
Topic Objectives 
In this topic, you will learn: 
 About desktop windows  
 How to resize windows  
 How to minimize, maximize, and restore windows 
 How to cascade, stack, and switch windows  
 How to view windows side by side 
 How to use the Shake and Peek functions 

 

ABOUT DESKTOP WINDOWS 

When you choose to open an application or an app, a window will appear for that item on 
the desktop. This window contains the application. It can be moved around, resized, and 
organized in relation to other windows to facilitate the ability to work with multiple apps at 
once.  
 
Desktop windows for applications tend to incorporate the same interface style and controls. 
For example, let’s look at the window for the Microsoft WordPad desktop application: 
 

 
 
Along the top of this window is the title bar (1) which shows the name of the application 
and the name of the file that is currently open. In the upper right-hand corner of the 
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window, you will also see the Minimize, Maximize/Restore, and Close controls (2). The 
window itself is represented by a very thin colored border around the application. (Keep in 
mind that this border will not be visible if the window has been maximized.) The content of 
the application will be displayed inside this border. 
 
App windows appear slightly different, but include the same basic components like the title 
bar and the thin colored border:  
 

 
 

RESIZING WINDOWS 

Any window that is not minimized or maximized can be manually resized. To do this, move 
your mouse pointer to the outside edge of an open window. When the mouse pointer 
changes to , , or , click and drag the border of the window to make it as large or small 
as you like:  
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USING MINIMIZE, MAXIMIZE/RESTORE, AND CLOSE 

The Minimize, Maximize/Restore, and Close buttons are located in the upper right-hand 
corner of almost every window you open on the desktop:  
 

 
 

Clicking the Close button will close the window or program: 
 

 
 
The Minimize button is used to reduce the window to a single icon on the taskbar: 
 

 
 

The middle button is a dual-use button. The most common form it takes is Maximize ( ), 
which when clicked will make the window fill your entire screen (with the exception of the 
taskbar):  
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When a window is maximized, the Maximize button will change to Restore Down ( ). 
When this button is clicked, it will restore the window back to the size it was before it was 
maximized: 
 

 
 

USING CASCADE, STACK, AND SIDE BY SIDE FUNCTIONS 

Windows 10 also includes several options that will automatically arrange all open windows. 
To access these options, open the windows that you would like to arrange and right-click on 
a blank area of the taskbar:  
 

 
 

In the middle of the context menu that appears, you will see three window management 
options: “Cascade windows,” “Show windows stacked,” and “Show windows side by side.”  
 
Clicking the “Cascade windows” option will place all open windows into a neat overlapping 
stack:  
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Clicking the “Show windows stacked” option will display all open windows in a vertical 
stack:  
 

 
 
Finally, clicking the “Show windows side by side” option will display all open windows 
beside each other:  
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(If there are only two windows, then you will see them in a similar configuration as if you 
were to use the “Show windows stacked” option.)  
 

USING SHAKE AND PEEK FUNCTIONS  

If you’re working with a lot of windows, you will find that they will sometimes clutter your 
desktop. This can become problematic when you would like to focus on just one window. 
The Shake function will cut through the clutter by minimizing every window except the one 
that you are working with. 
 
To use this feature, click on the title bar of the window you would like to work with. While 
holding down your left mouse button, give it a quick shake from side to side: 
 

 
 
This action will cause all windows except the active one to be minimized:  
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If you are working with a window or multiple windows and you would like to get a quick 
look at the desktop, press and hold Win + , (comma) on your keyboard. As long as you hold 
this key combination, you will be able to see your desktop:  
 

 
 

(Note that a transparent outline will denote any currently open windows. Additionally, you 
will be unable to interact with any items on the desktop.) 
 

ACTIVITY 3-1 
Working with Desktop Windows 
 
During your typical workday you find yourself using multiple applications at the same time. 
You would like to practice managing the windows for these applications so that you can be 
more efficient.  
 

  To begin, sign into your Windows 10 account.  

  

2.  On the taskbar, click the Microsoft Edge icon to open that program:  
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3.  The Microsoft Edge window will now be displayed. If this window isn’t maximized, 
click the Maximize button in the upper right-hand corner:  
 

 
 
(If the window is already maximized, skip to the next step.) 

  

4.  Click the File Explorer icon on the taskbar:  
 

 

  

5.  A File Explorer window will now open and show you the “Quick access” screen: 
 

 

6.  Click the Store icon on the taskbar to open it. Your screen will now look similar to 
this: 
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7.  Your screen is getting pretty cluttered at this point. Right-click a blank area of the 
taskbar and click “Cascade windows:”  
 

 

   

8.  All of the open windows will now appear in an overlapping stack. On top of this 
stack will be the last window that was displayed – Store in this case:  
 

 

9.  Next, peek at the desktop by pressing and holding Win + , (comma) on your 
keyboard:  
 

 
 
(Note the transparent outlines of the currently open windows.)  
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10.  Release the key combination to stop peeking at the desktop: 
 

 

   

11.  Click and hold the title bar of the Store window and rapidly shake it from side to 
side. The two other windows will be minimized automatically:  
 

 

   

12.  In the top right-hand corner of the Store window, click the Close button:  
 

 

  

13.  Close any remaining windows using the Close button. Sign out of your Windows 10 
account to complete this exercise. 
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TOPIC B: Manage Files and 
Folders with File Explorer 
 
One of the tasks that you will use Windows 10 for is to organize and manage files. The 
primary tool to facilitate this task is File Explorer. Over the course of this topic you will learn 
all about File Explorer and how to use it to manage files and folders.  
 
Topic Objectives 
In this topic, you will learn: 
 About files, folders, and libraries  
 About File Explorer  
 About tabs and the ribbon interface 
 About the Quick Access toolbar  
 How to pin locations for quick access in File Explorer 
 About the Recycle Bin 

 

FILES AND FOLDERS 

You can think of a computer like a filing cabinet. The smallest item you would put in a filing 
cabinet would be a single sheet of paper with some information on it. This piece of paper is 
comparable to a single file on your computer. Very large files may be several pieces of paper 
stored together, but they would still be considered a single, albeit large, entity:  
 

 
 

Continuing with our filing cabinet example, a folder in Windows is exactly like a folder you 
would find in a filing cabinet. Many files can fit inside of it, and a folder can be named 
anything at all. Folders can even contain other folders:  
 

 
LIBRARIES 

Libraries are an important organizational component that was first introduced in Windows 
7. To continue with our filing cabinet example, a library can be thought of as a group of files 
and folders that are all related in some way but are separated by some sort of divider inside 
a drawer of the filing cabinet.  
 
A library’s primary advantage as opposed to standard folders is that they can reference files 
and folders that are located anywhere on your computer, even on networks.  
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In Windows 10, there are four default libraries:  
 

 
 

In addition to these default options, you can create your own, custom libraries. 
 

One thing that you need to keep in mind about libraries in Windows 10 is that, with the 
exception of a few individual ones that are listed in the “Quick access” area, the primary 
libraries list is hidden from File Explorer by default. To display the libraries list within the 
Navigation pane of File Explorer, right-click a blank area of the Navigation pane and click 
“Show libraries:”  
 

 
 

GETTING TO KNOW FILE EXPLORER 

File Explorer (previously known as Windows Explorer in Windows 7 and earlier) is the key 
tool that you will use to keep your files and folders organized.  
 
Opening File Explorer 
While you can find and open File Explorer from the “All apps” list on the Start menu, it is 
often quicker to click the File Explorer icon on the taskbar:  
 

 
 
Or, press Win + E on your keyboard. Additionally, keep in mind that File Explorer will 
automatically open whenever you double-click on a folder on your desktop.  
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The File Explorer Interface 
When you open File Explorer, it will look something like this:  
 

 
 

Let’s look at the different components. 
 

Title Bar (1) The title bar of the File Explorer window will display the current folder or 
library that is open, as well as the Minimize, Maximize, and Close buttons. 
You will also notice a row of icons on the left. This is the Quick Access 
toolbar, which will be discussed in the next topic. 

Ribbon 
Tabs (2) 
 

Click a ribbon tab to display related commands:  
 

 
 

Note that additional tabs (called contextual tabs) may be available 
depending on the folder that you are viewing. For example, the Recycle 
Bin and libraries both have contextual tabs. 

Address 
Bar (3) 

The address bar displays what folder is currently open, as well as a 
breadcrumb trail showing the parent folder. You will also see some simple 
navigation controls as well as a search field:  
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Navigation 
Pane (4) 

The Navigation pane displays a list of quick access 
locations (such as your desktop), libraries, your 
OneDrive folder, your PC, hard drives, removable 
devices, and network locations:  
 

 

Working 
Area (5) 

Finally, the working area will display the files or folders within the location 
you’re currently viewing:  
 

 
 
 

TABS AND THE RIBBON INTERFACE 

File Explorer contains four basic tabs by default: File, Home, Share, and View. Below is a 
breakdown of the types of commands on each tab. 
 
File  
The File menu in File Explorer contains 
the following commands (shown on 
the right):  
 
The right-hand side of the File menu 
will display frequent locations. Click 
any items within this list to open 
them. You will also notice that you can 
pin frequently visited places to this 
menu by clicking the pushpin icon to 
the right of each entry. Some items 
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will already be pinned by default, like the desktop.  
 
On the left-hand side of the File menu, you will see commands to open all kinds of different 
tools in Windows 10, as well as new File Explorer windows. In addition, you will also see a 
link to Help and a command to close the File Explorer window. 
 
Home 
This tab contains five groups with general productivity and organizational commands:  
 

 
 
Here is breakdown of each group within this tab:  
 

Clipboard The Clipboard group contains commands related to copying and pasting. 
For example, you can see that there are general cut, copy, and paste 
commands as well as commands to copy file paths and paste shortcuts. 
Additionally you will see a command to pin the selected item to the “Quick 
access” portion of the Navigation pane.  

Organize The Organize group includes four commands that allow you to move, copy, 
rename, and delete items. 

New The New group provides commands to create new items in the current 
folder. As well, the “Easy access” button allows you to include files or 
folders in a library, map them as a drive, and modify network options.  

Open The Open group contains commands to view more information about the 
selected file or folder. You can also open the selected item. 

Select The last group on this tab provides three different commands to select 
items. 

 
 
Share 
This tab in File Explorer contains just two groups:  
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Here is a breakdown of each group within this tab:  
 

Send The Send group of the Share tab contains several commands you can use 
to share selected item(s). You can open the Share task pane, e-mail the 
item(s) as an attachment, zip it, burn it to disc, print it, or even fax it.  

Share with This group allows you to share files and folders with other users on the 
same network as you. Also in this group you will see a command that will 
open security settings for the current item. 

 
View  
This tab controls how you view, sort, and group files:  
 

 
 
Here is a breakdown of each group within the View tab: 
 

Panes This group contains controls to 
toggle the Navigation pane, Preview 
pane, and Details pane on or off. 
The Preview pane is useful when 
trying to find a particular 
photograph or file:  
 

 
 
 
 
 
The Details pane will display more 
technical information about the file, 
including the file size, date, and 
more:  
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Layout This group contains a gallery of possible layout styles for the working area. Just 
click on a style to apply it. Use the arrows on the right of the gallery to see all of 
the available options:  
 

 
 

Current 
view 

The next group allows you to control how items in the File Explorer window are 
sorted and grouped. For example, if you wanted to sort your Pictures folder by 
date, you would use the “Sort by” drop-down command in this group:  
 

 
 

You can also customize the Details view with the “Add columns” and “Size all 
columns to fit” commands.  

Show/hide The final group in this tab allows you to show and hide various elements in File 
Explorer:  
 

 
 

By default, all of these items will be unchecked. This group also contains a 
command to open the Folder Options dialog. In this dialog, you can further 
customize how you interact with and view items in File Explorer.  

 
  



[119] Microsoft Windows 10 – Part 1 

© All rights reserved.  119 of 311 
 

Contextual Tabs 
Additional tabs may appear on the File Explorer ribbon depending on the type of file that 
you have currently selected. For example, if you select a picture file, the Picture Tools – 
Manage contextual tab will be shown on the ribbon, which you can then select: 
 

 
 

The commands that are available on each of these tabs are all different, but relate to the 
selected item. For example, if you have a picture selected, the Picture Tools – Manage tab 
will provide you with controls to rotate the picture, set it as a background, present it in a 
slide show, and even cast (send) it to a connected device.  
 

THE QUICK ACCESS TOOLBAR 

Like many other applications, File Explorer incorporates a Quick Access toolbar. This toolbar 
is fully customizable and allows you to add any commands that you wish. The idea behind 
this feature is that you can add commonly used commands to this toolbar so that you will 
always have ready access to it and not have to dig through the tabs on the ribbon.  
 
The Quick Access toolbar is found in the upper left-hand corner of the File Explorer window: 
 

 
 
By default you will see two commands: Properties and New 
Folder.  To add a new command, click the drop-down arrow 
to the right of Quick Access toolbar and click on one of the 
commands that are listed (shown on the right):  

 
(Items with a checkmark have already been added to the 
Quick Access toolbar. Clicking on these items will remove 
them.)  
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Alternatively, you can right-click on a command that appears directly on the ribbon and 
click, “Add to Quick Access Toolbar:” 
 

 
 
To remove a command, right-click on it directly within the Quick Access toolbar and click, 
“Remove from Quick Access toolbar:”  
 

 
 

PINNING LOCATIONS FOR QUICK ACCESS 

Formerly known as the Favorites section, the “Quick access” section in the Navigation pane 
of File Explorer gives you a place where you can quickly access your most frequently used 
folders and libraries: 
 

 
 
There are a few different ways that you can pin a folder or library to this section in the 
Navigation pane.  
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You can click and drag the item from the working area of File Explorer to the “Quick access” 
section:  
 

 
 
(Note that when dragging items to the “Quick access” list, the black bar indicates the 
positioning of the item in the list.) 
 
You can also right-click an item and click “Pin to Quick access” on the context menu:  
 

 
 
Or, click to select an item and then click Home → Pin to Quick access:  
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To unpin an item from the “Quick access” list, right-click the item in question and then click 
“Unpin from Quick access:”  
 

 
 

THE RECYCLE BIN 

If you delete an item by selecting it and pressing the Delete key on your keyboard or right-
clicking it and clicking Delete, the item is moved to the Recycle Bin before it is completely 
deleted. 
 
The Recycle Bin is accessible from the desktop and it is opened by double-clicking its icon: 
 

 
 
When the Recycle Bin is open, it will look like any other folder you can view using File 
Explorer. There is an address bar and search field at the top, a list of links to other locations 
on your computer on the left, and the contents of the Recycle Bin in the middle. However, 
the contextual Recycle Bin Tools – Manage tab is also available on the ribbon: 
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To restore all items in the Recycle Bin and return them to their original locations, click 
Recycle Bin Tools – Manage → Restore all items: 
 

 
 
If there is anything to restore, you will be asked to confirm your choice: 
 

 
 

Click Yes to move the items in the Recycle Bin back to their original locations. 
 
To delete items in the Recycle Bin permanently, click Recycle Bin Tools – Manage → Empty 
Recycle Bin: 
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If there is anything to delete, you will be asked to confirm your choice. Click Yes to delete 
the items: 
 

 
 

(Note that this dialog box will look slightly different if there is only one item in the Recycle 
Bin.) 

 
As well, you can delete individual files or folders by selecting the items to delete in the 
Recycle Bin and pressing Delete on your keyboard.  
 
 

ACTIVITY 3-2 
Managing File and Folders with File Explorer 
 
To better understand how to keep the files and folders organized on your computer, you 
would like to practice using File Explorer. 
 

1.  To begin, log into your Windows 10 account.  

  

2.  On the desktop you should see the Exercise Files folder. Double-click this folder to 
open it in File Explorer. 

 
Note that the folder icon indicates that it contains multiple folders and files. 
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3.  Your Exercise Files folder will now be open in File Explorer. Double-click the 
“Starting Files for Activities” folder: 
 

 

  

4.  The contents of the “Starting Files for Activities” folder will now be shown. Double-
click the “Lesson 3” folder:  
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5.  With the contents of the “Lesson 3” folder now shown in File Explorer, you will see 
the “Presentation” folder. Double-click it:  
 

 

   

6.  The contents of the “Presentation” folder will now be shown. As you can see, it 
contains a variety of different file types: 
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7.  There’s an image file in this folder that you would like to preview. Enable the 
Preview pane by clicking View → Preview pane: 
 

 

   

8.  With the Preview pane now displayed on the right side of the File Explorer window, 
click to select the image file (img0). You will see a preview of this image now 
displayed in the Preview pane:  
 

 
 

(Note the Picture Tools – Manage contextual tab that is displayed on the ribbon 
while the picture is selected.) 

   

9.  Disable the Preview pane by deselecting the “Preview pane” command on the View 
tab:  
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10.  Click to select the “img0” file and then click Home → Delete:  
 

 

  

11.  The selected file will now no longer be listed within the Presentation folder as it 
has been moved to the Recycle Bin:  
 

 

   

12.  Return to the previous Lesson 3 folder by clicking the Back button: 
 

 

  

13.  Inside the address bar you will see a breadcrumb trail that lists some of the various 
parent folders that contain the current one. Click the “Starting Files for Activities” 
folder:  
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14.  To the immediate left of the address bar, click the Up arrow to view the parent 
folder of the current one: 
 

 

  

15.  You will see the contents of the parent folder (your Exercise Files folder), including 
the “Starting Files for Activities” folder that you were just viewing:  
 

 

  

16.  Click Desktop from inside the “Quick access” section of the Navigation pane:  
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17.  Any files or folders that reside on your desktop will now be displayed within File 
Explorer. Add your Exercise Files folder to the “Quick access” section by right-
clicking on that folder and clicking “Pin to Quick access:”  
 

 

  

18.  You Exercise Files folder will now appear within the “Quick access” list:  
 

 

  

19.  Double-click the Recycle Bin icon that is on the desktop:  
 

 
 
(Note that it appears full to indicate that it currently holds at least one item.) 
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20.  A new File Explorer window will open and display the contents of the Recycle Bin:  
 

 

  

21.  Inside the new File Explorer window, click Recycle Bin Tools – Manage → Restore 
all items: 
 

 

  

22.  A dialog box will ask you to conform your choice to restore the items within the 
Recycle Bin. Click Yes:  
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23.  The image file that you deleted previously will now have been restored to its 
original location and the Recycle Bin will appear empty: 
 

 

  

24.  Close all open File Explorer windows and sign out of your Windows 10 account to 
complete this exercise.  
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TOPIC C: Create and Modify 
Files with Desktop 
Applications 
 
Windows 10 is preloaded with some basic applications that allow you to do all sorts of 
different tasks. For example, File Explorer lets you navigate through the folders and files 
that are stored on your computer, Microsoft Edge lets you browse the Internet, and 
WordPad lets you open and create simple documents. Many of these applications (and 
others) use the same techniques to complete basic tasks. Throughout this lesson, you will 
learn how to use these features.  
 
Topic Objectives 
In this topic, you will learn: 
 How to create, open, save, and print documents  
 How to use the Clipboard  
 About the Undo and Redo features  

 

CREATING NEW DOCUMENTS 

Using Windows you can create documents or files without even having to open the 
associated application. For example, suppose that you wanted to create a new document in 
WordPad. All you would need to do is right-click on the desktop or in the folder in which you 
want the document to be stored. Then, on the context menu that appears, click New → Rich 
Text Document:  
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The new file will then be created in the current folder and the file name will appear selected 
so that you can rename it to whatever you like:  
 

 
 
To create a new document or file from within an application itself, the process can vary 
from application to application. Typically, as is the case with WordPad, you would click File 
→ New: 
 

 
 

If the current application only allows you to view one unsaved document at a time (as is the 
case with WordPad), it will first ask you if you would like to save the current document 
before closing it and then opening the new one.  
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OPENING EXISTING DOCUMENTS 

By far, the quickest method to open any existing document or file is to double-click on it 
from within File Explorer or on your desktop:  
 

 
 

This action will automatically open the selected file within its native application. For 
example, if you double-click a .txt file it will automatically open in Notepad:  
 

 
 
Alternatively, you can usually open existing files from directly 
within an open application. For example, suppose that you 
wanted to open a text file from within the Notepad 
application. First, you would click File → Open:  
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Notepad will display the Open dialog box, but some other applications may have 
information built directly within the window. In either case, you would then navigate 
through the files and folders on your computer (just like you would in File Explorer) to find 
the file that you would like to open. Next, click to select the file in question and click the 
Open button:  
 

  
 
The file will then open in the currently displayed application:  
 

 
 
Remember that while the menus and command appearances will differ from application to 
application, the process is generally the same.  
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SAVING DOCUMENTS 

The ability to save documents so that you can easily refer to them or work on them later is a 
key component of what makes computers so ubiquitous today. Whether you have finished 
working on a document (or if you would just like to make sure you don’t lose any of your 
work), you can save it to your computer’s hard disk. (Keep in mind that if you are working 
with an existing file and don’t change the file name, any changes that you made to it will 
overwrite the previous version of the file when you save it.)  
 
In many applications, the process to save a document is to click File → Save, or File → Save 
As:  
 

 
 
If you are saving a document for the first time, you can choose either of these options and 
the Save As dialog (or a variation of it) will be displayed. However, if you are saving an 
existing document, it is important to know the difference between these two options. The 
Save option will save the document using the original file name and overwrite the previous 
version. Clicking the Save As option will display a Save As dialog.  
 
The Save As dialog is like the Open dialog, but instead of finding an existing file you are 
choosing a save location, file name, and in some cases a file type:  
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After having chosen a location for the file, you are able to choose a more descriptive name 
than the default “Document1” name which is typically used. However, keep in mind that file 
names cannot includes many special symbols, including the following: < > : “ / \ | ? *. 
 
When you are ready to save the current document, click the Save button and the document 
will be save to the selected location, using the chosen file name and file type (if applicable).  
 

THE CLIPBOARD 

Often you may hear people talk about the Clipboard on a computer. This is a tool that 
facilities the copying, cutting, and pasting of items between applications and windows itself. 
The most important aspect of the clipboard to remember is that you can only copy or cut 
one selection at a time. For example, if you copy a sentence from a document and then copy 
a folder from your desktop, the copied sentence will no longer be able to be pasted – only 
the folder.  
 
Here is a breakdown of the various functions that the Clipboard supports. Note that you can 
typically find these commands on the context (right-click) menu or under an Edit menu/tab. 
 
Cut (Ctrl + X shortcut)  
Using this command, a selected item will be removed from its current location and placed 
on the Clipboard. You can then paste it to a different location. You will typically use this 
command to move an item:  
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Copy (Ctrl + C shortcut)  
This command will create a copy of the selected item and place the copy on the Clipboard, 
leaving the original item unchanged. You can then paste the copied item to a different 
location.  
 

 
 
Paste (Ctrl + V shortcut) 
This command will place whichever item currently exists on the Clipboard in a new location.  
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Paste Special (keyboard shortcut varies) 
This command allows you to place whichever item(s) exist on the Clipboard in the format of 
your own choosing. For example, if you copied a sentence that appears in a red font, you 
could choose to place the copy using that formatting, a basic plain formatting, or matching 
the surrounding formatting. This feature is not available for every application.  
 

UNDO AND REDO 

Everyone makes mistakes and the people who create software applications know that. To 
help make these mistakes as least painful as possible, virtually every application supports 
some form of undo function so that you can undo a previous action.  
 
For example, suppose that you accidentally deleted an important paragraph from a report 
you were composing in Microsoft Word. Rather than have to type it out again, all you would 
have to do is use the Undo feature by pressing Ctrl + Z on your keyboard or clicking the 
Undo command.  
While the location of this command varies widely from application to application, you can 
typically find it on the Quick Access toolbar of the application in question or in an Edit 
tab/menu:  
 

 
 
Rather than undo your previous action, the Redo command will repeat it. This allows you to 
save time from manually repeating a simple action, like inserting a single slide into a 
presentation. Like the Undo command, you can typically find the Redo command on the 
Quick Access toolbar or in an Edit tab/menu. You can also press Ctrl + Y on your keyboard: 
 

 
 

PRINTING DOCUMENTS  

If you need a hard copy of a document, you will typically have the option to print it out on 
paper using a printer. To facilitate this process, most applications include a Print command, 
which is typically accessed from the File menu or by pressing Ctrl + P on the keyboard.  
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In most cases, the Print dialog box will be used to configure print options:  
 

 
 
This dialog box allows you to select the printer that you would like to use (1), the page 
range to print (2), and the number of copies (3). Set your options and click Print to send the 
document to the printer. 
 
Occasionally you may see that an application has a Quick Print option. Choosing this option 
will send the current document directly to the default printer using the default printer 
settings. This is also what happens if you choose to print a file by right-clicking the file from 
inside File Explorer or on your desktop and choosing Print:  
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Some applications also support the Print Preview function. This option will provide you with 
a preview of how the current document will look on the printed page using the current print 
settings:  
 

 
 
 

ACTIVITY 3-2 
Creating and Modifying Files with Desktop 
Applications 
 
In this activity, you will open and edit a simple rich text file using WordPad. 
 

1.  To begin, log into your Windows 10 account. 

  

2.  Open your Exercise Files folder. Open the “Starting Files for Activities” folder and 
then open the “Lesson 3” folder. Inside this folder you will see the Activity 3-3 file. 
Double-click it:  
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3.  This file will automatically open in the application that is associated with rich text 
files. By default this will be WordPad:  
 

 
 
(If Microsoft Word or another word processor opens, you should still be able to 
follow the remaining steps in this activity. However, the interface will look different.) 

  

4.  The first and second paragraphs are out of order and need to be swapped with one 
another. Click and drag your cursor over the entire first paragraph to select it:  
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5.  Right-click this selection and then click Cut:  
 

 

   

6.  The previously selected paragraph will now have been removed from the page and 
placed onto your computer’s Clipboard. With your cursor now placed where this 
paragraph used to be, press the Delete key on your keyboard twice to remove the 
two extra lines that now exist:  
 

 

   



[145] Microsoft Windows 10 – Part 1 

© All rights reserved.  145 of 311 
 

7.  Click to place your cursor at the end of the paragraph I. Press Enter twice to make 
room for the passage that you previously cut. The document will now look like this, 
with your cursor placed evenly between the two existing paragraphs:  
 

 

   

8.  Press Ctrl + V on your keyboard. The previously cut passage will be pasted into the 
current location: 
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9.  You would like to save this document as a new file so that you do not overwrite the 
existing version. Click File → Save as:  
 

 

   

10.  The Save As dialog box will now be displayed. Click the Desktop link from the “Quick 
access” area:  
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11.  The file name will display the current one (Activity 3-3). Click to place your cursor at 
the end of this name and add a space. Type “Complete” and then click the Save 
button:  
 

 

  

12.  The current document will now have been saved to the location that you specified. 
Note that the title bar of the open file will change to incorporate the new file name:  
 

 

  

13.  Close WordPad and then sign out of your Windows 10 account to complete this 
exercise.  

 
 

Summary 
Over the course of this lesson you learned about some of the ways that you can work with 
the desktop and desktop applications in Windows 10. You should now be comfortable 
managing desktop application windows, as well as files and folders. You now know what the 
File Explorer is used for and how to use it. Additionally, you are now able to complete basic 
actions (such as save, undo, and print) in most desktop applications. 
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LESSON 4: 
USING MICROSOFT EDGE 

 
 
 

Lesson Objectives 
 

In this lesson you will learn how to: 

 Navigate the Microsoft Edge user interface 

 Browse the web using Microsoft Edge 

 Manage tabs 

 Modify Microsoft Edge options  
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TOPIC A: Navigate Microsoft 
Edge 
 
One of the biggest changes that you will find in Windows 10 is the inclusion of Microsoft 
Edge as the default web browser. This entirely new application is designed as a lightweight 
web browser that offers integration with Cortana and OneDrive, amongst other features. 
Over the course of this topic, you will learn all about this new browser and its features.  
 
Topic Objectives 
In this topic, you will learn: 
 About web browsers and search engines  
 About Microsoft Edge and Internet Explorer 
 About the Microsoft Edge interface  
 About URL’s  
 About Bing 

 

WEB BROWSERS AND SEARCH ENGINES 

A web browser is a type of application that has been designed to display web pages that are 
stored on a network. A network could refer to the World Wide Web (“the web” for short) as 
a whole, or an internal organization-wide intranet. While the Microsoft Edge and Internet 
Explorer web browsers are both included with Windows 10, there are a variety of other 
different web browsers that you can download and install. Mozilla Firefox and Google 
Chrome are popular choices.  
 
A search engine typically refers to an online service that searches the web based on terms 
that you enter. When this search is done, a list of results will then be displayed on a web 
page that you can search and navigate through using the provided links. While Windows 10 
(including Cortana) is fully integrated with the Microsoft Bing search engine, Google is also a 
very popular search engine that you can use to find the information that you need.  
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MICROSOFT EDGE AND INTERNET EXPLORER 

The Microsoft Internet Explorer (IE) web browser was first introduced in Windows 95. It has 
been the default Windows web browser ever since. While it was one of the most popular 
browsers used on the web at the turn of the millennium, its popularity has waned rapidly 
with the rise of Mozilla Firefox, Google Chrome, and Apple’s Safari web browser.  
 
With the release of Windows 10, Internet Explorer has been replaced with Microsoft Edge. 
This is a new product that is designed to address many of the shortcomings that Internet 
Explorer had. As the new default web browser for Windows, it features many of the same 
features that were found in IE, but it also includes full integration with Cortana. 
 

ELEMENTS OF THE MICROSOFT EDGE WINDOW 

When Microsoft Edge is open, you will see that its interface is fairly basic. This is by design 
so that you can focus on the web pages that are being displayed, rather than be distracted 
by a complicated interface. Additionally, the interface can change slightly to incorporate 
different elements.  
 
For example, by default when you first open Microsoft Edge, the Start tab will be displayed. 
This tab includes local news and weather information, as well as the address bar, which has 
been moved lower in the window: 
 

 
 
This is the same structure that is used when you open a new tab, but rather than news and 
weather you will see a grid showing frequently visited and/or suggested websites:  
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As the Start tab is the most common state of Microsoft Edge, let’s break down each element 
of the interface while a web page is displayed: 
 

 
 
Here is a description of each element. 
 Content (1): The majority of the Microsoft Edge interface consists of the web page 

that you are currently visiting.  
 Back/Forward (2): These two buttons are used to move back or forward to pages 

that you have previously visited.  
 Address bar (3): This is where you can enter the URL of the website that you would 

like to visit. Additionally, you can enter search terms into this bar to execute a search 
using Bing.  

 Tabs (4): Each tab represents a web page. There will be always at least one tab open. 
You may open multiple tabs to view multiple web pages at the same time.  

 Refresh (5): Clicking this button will reload the currently displayed webpage to 
display the most up-to-date version.  
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 Minimize/Maximize (Restore)/Close (6): Just like any other desktop application 
window, you can use these buttons to minimize, maximize/restore, and close the 
Microsoft Edge window.  

 Hub/Make a Web Note/Share/More actions (7): The Hub button will display the 
Hub pane. This is where you can access your favorites, history, reading list, and 
downloads. Clicking the “Make a Web Note” button allows you to add notations 
directly to a web page. The Share button will display the Share pane, which you can 
use to share the current web page with others. Finally, the “More actions” button 
gives you access to several different settings in Microsoft Edge.  

 Reading view/Add to favorites or reading list (8): Clicking the “Reading view” button 
will strip a blog post or news article down to only the basic article content. The “Add 
to favorites or reading list” button allows you to add the current web page to your 
reading or favorites list.  

 

URL’S 

URL’s (Uniform Resource Locators) are references that point to other resources on the 
Internet. Commonly referred to as addresses, you can enter them into the address bar in 
Microsoft Edge. This will display the page within the working area of the browser.  
 

BING 

Bing is Microsoft’s own search engine. You can access this service by searching using 
Cortana or typing terms directly into the address bar of Microsoft Edge. You can also access 
it by visiting the bing.com website:  
 

 
 
If you type search terms into the provided text box on the Bing home page (or in the 
address bar) a list of suggestions will be presented.  
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By pressing the Enter key or clicking the associated Search button, a list of results in the 
form of URL’s will be presented:  
 

 
Searching by Category  
Along the top of the Bing home page, you will find a list of categories that provide you with 
access to a variety of different search categories such as Web (selected by default), Images, 
Videos, Maps, News, More, and Search History. Additionally, you will see links to access the 
MSN home page, Office Online, Outlook.com, and your Microsoft account information:  
 

 
 
Popular Now Links 
Along the bottom of the Bing home page, you will see some featured stories and 
information about the home page’s background photo. Additionally, under the Popular Now 
header, you will see what search terms are trending: 
 

 
 
 

ACTIVITY 4-1 
Navigating Microsoft Edge 
 
You would like to familiarize yourself with Microsoft Edge and its interface. To practice, you 
would like to visit the Bing home page. 
 

1.  To begin, sign into your Windows 10 account. 
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2.  On the taskbar, click the Microsoft Edge button:  
 

 

  

3.  The Microsoft Edge window will now be displayed on the desktop. By default, the 
Start page will be displayed with news, weather, and sports information:  
 

 

  

4.  Inside the provided text box, type “bing.com” and press Enter on your keyboard:  
 

 
 

(Note that you can also type search terms directly into this text box and press Enter 
to search with Bing.) 
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5.  The Bing home page will now be displayed within the Microsoft Edge window. 
Notice that its URL is displayed within the address bar:  
 

 

   

6.  Inside the search bar on the Bing home page, type “Red panda.” You will instantly 
see several search suggestions and some basic information about the subject. Press 
Enter: 
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7.  A list of URL results will be presented. On the right side of the page you will see 
some summary information about the subject that you were searching for:  
 

 
 

(Note that this summary information isn’t always displayed, but it can be very 
useful for quick searches.) 

   

8.  Just below the search text box, click the Images category:  
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9.  Now only image search results will be displayed, along with some suggested search 
terms:  
 

 

   

10.  Click inside the address bar and replace the existing text with “snowy owl.” You will 
see that like the Bing home page, search suggestions will be listed: 
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11.  Press the Enter key. A new Bing image search results page will now be displayed:  
 

 

  

12.  Near the upper left-hand corner, click the Back button:  
 

 

  

13.  The previous page will now be displayed:  
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14.  In the upper right-hand corner of the Microsoft Edge window, click the Close 
button:  
 

 

  

15.  Sign out of your Windows 10 account to complete this exercise.  
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TOPIC B: Use Microsoft Edge 
 
Microsoft Edge provides you with all of the tools that you need in order to browse the web. 
Over the course of this topic, you will examine many of these tools and learn how to use 
them effectively.  
 
Topic Objectives 
In this topic, you will learn: 
 About the address bar 
 How view frequently visited websites  
 How to view your favorites  
 How to view your Reading List  
 How to view your history  
 How to view a page using Reading view 
 How to create web notes  
 How to share web pages with others  
 How to use Cortana in Microsoft Edge 

 

THE ADDRESS BAR 

In the Microsoft Edge interface, the address bar is not only the place where you enter 
website URL’s; it is also where you can enter search terms that are then sent to Bing. For 
example, suppose that you wanted to find some information about koalas. First, you would 
type “Koalas” into the address bar:  
 

 
 
 
After entering those search terms, press the Enter key on your keyboard or click the Search 
button. A Bing search results page will then be displayed:  
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Search Suggestions 
As you type a URL or search terms into the address bar, you will see a list of search 
suggestions based on what you have typed:  
 

 
 
This list can include previous searches that you have performed, as well as popular searches 
that include the keywords that you entered. You can save time when executing a search by 
clicking on one of the suggestions.  
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VIEWING FREQUENTLY VISITED WEBSITES 

By default, whenever you open a new tab in Microsoft Edge a list of the most popular 
websites and sites that you frequently visit will be listed:  
 

 
 

Clicking on any of the items listed here will open their associated website in the current tab. 
To remove an item from this list, move your cursor over that item and then click the X 
button in its upper right-hand corner: 
 

 
 
If you wish, you can also choose to include your news feed on this page by clicking the 
“Show my news feed” link near the bottom of the page.  
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Clicking the Customize link on the right side of the top sites list will also give you the option 
to enable your news feed on this page, but you can customize the topics that you would like 
it to include. Additionally, you have the option to simply have a new tab appear as a blank 
page:  
 

 
 

VIEWING YOUR FAVORITES 

Your favorites in Microsoft Edge are a list of web pages that you choose specifically to mark 
so that you can easily come back to them in the future. As your Favorites list is a component 
of the Hub, you can view it by clicking the Hub icon ( ) near the top right-hand corner of 
the window: 
 

 
 
With the Hub pane displayed, click the Favorites icon ( ): 
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With the Favorites pane displayed, you will see a list of all your favorites and folders that 
can be used to organize them: 
 

 
 

Clicking on any favorite that is listed here will open its associated website in the current tab. 
To view the contents of a folder, click on it. In addition to displaying the folder’s contents, 
you will see a breadcrumb trail that lists all of the parent folders. In this example, you can 
see that the Favorites Bar folder is stored just inside the Favorites folder:  
 

 
 

You can return to any of the parent folders that are listed here by clicking on them. 
 

Managing Favorites 
Favorites can be moved to a folder by clicking and dragging them to the folder in question. 
You can also use the same technique to move a favorite out of a folder, but using the 
breadcrumb trail instead:  
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To create a new folder inside your favorites, right-click any item inside the favorites list and 
click “Create new folder:”  
 

 
 

(You can also see options to rename or remove the selected item.) 
 

With a new folder created, you will immediately be given the option to give it a more 
descriptive name:  
 

 
 

Pressing the Enter key will apply the new name.  
 
Adding a Favorite 
To add a web page to your Favorites list, first open the web page in question. Next, click the 
star icon ( ) to the right of the address bar:  
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A menu will be displayed that allows you to customize the name for this new favorite, 
choose where you would like to create it (as well as create a new folder), and add it or 
cancel the process entirely: 
 

 
 

Once a web page has been marked as a favorite, the star icon will appear yellow whenever 
you visit that page:  
 

 
 
If you click this icon again, you will be given options to modify the name of the favorite, 
change its save location, or remove it entirely: 
 

 
 

VIEWING YOUR READING LIST 

The Reading List feature in Microsoft Edge allows you to save articles that you would like to 
read later, but don’t necessarily want to clutter up your Favorites list with. As your Reading 
List is a component of the Hub, you can view it by clicking the Hub icon ( ) near the top 
right-hand corner of the Microsoft Edge window: 
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With the Hub pane displayed, click the Reading List icon ( ), if it isn’t already selected:  
 

 
 

With the Reading List displayed, you will see any articles that you marked to read later. 
Included in the listing will be the article title, a snippet of its content, and when it was added 
to the list. Clicking an entry will open it in the current tab: 
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To remove an article from the Reading List, right-click its listing and then click Remove:  
 

 
 
Adding an Article to the Reading List  
To add an article to the Reading List, ensure that that the article in question is displayed 
within the browser. Next, click the star icon ( ) to the right of the address bar:  
 

 
 
On the menu that appears, click the “Reading list” header if it is not selected already:  
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With the “Reading list” header selected, you will be able to customize the name if you wish. 
Clicking the Add button will add it to the list: 
 

 
 

It’s important to note that unlike when you add a web page as a favorite, pages that are 
added to the reading list will not cause the star icon to appear yellow. When you view these 
pages, the star icon will have a black outline.  
 

VIEWING YOUR HISTORY  

Microsoft Edge (and every other web browser) keeps a record of each website that you visit. 
This provides you with a quick way to return to recent websites. As your history is a 
component of the Hub, you can view it by clicking the Hub icon ( ) near the top right-hand 
corner of the Microsoft Edge window: 
 

 
 

With the Hub pane displayed, click the History icon ( ) if it isn’t already selected:  
 

 
 

Your history will now be shown. It is automatically categorized into dates and times. Your 
most current history will be listed under the “Last hour” category, while websites that you 
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visited in recent days will be categorized by date. Older pages will be listed under “Last 
week” or the “Older” category: 

 

 
 

You can expand or collapse any category that is listed here by clicking on their headers:  
 

 
 

Clicking on any of the web pages that are listed here will open them in the current tab.  
 
Clearing History 
To remove an item from your history, right-click the item 
in question and click Delete:  
 
Clicking the “Delete all visits to [domain name]” will 
remove all history related to that site. For example, if you 



[172]  Microsoft Windows 10 – Part 1 

© All rights reserved.  172 of 311 
       

click this option for bing.com, not only will the current item be removed, but any previous 
searches that you made will be removed also. 
 
You can also remove entire categories by clicking the X next to each category:  
 

 
 
Finally, if you would like to clear your entire history, click the “Clear all history” link near the 
top right-hand corner of this pane:  
 

 
 
This action will cause a list of options to be displayed. Using these controls you can choose 
exactly what you would like to clear from your history 
(displayed on the right):  
 
By default the “Browsing history,” “Cookies and 
saved website data,” and “Cached data and files” 
options will already be selected. Clicking the Clear 
button will complete the action.  
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USING READING VIEW 

Reading view is a feature that is now becoming more common in web browsers today. Its 
purpose is to strip an article or blog post from any distracting elements, such as 
advertisements and navigation tools, so that you can focus on the content. You can toggle 
this feature where applicable by clicking the book icon ( ) on the far right-hand side of the 
address bar:  
 

 
 
Once this view is enabled, the page will feature a simple column of content:  
 

 
You can return to the standard web view by clicking the same icon.  
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CREATING WEB NOTES 

Web notes are annotations that you can add any web page that is displayed in Microsoft 
Edge. They allow you to add notes, highlight items, and even draw on the page. To start 
creating web notes on a currently displayed web page, click the “Make a Web Note” icon 
near the top right-hand corner of the Microsoft Edge window:  
 

 
 

As web notes are powered in part by Microsoft OneNote, the Microsoft Edge window will 
now incorporate an OneNote-inspired purple toolbar:  

 

 
 
The far left of the toolbar includes the followings tools:  
 

Pen 

 

This tool allows you to draw freehand over the current web page. 
For example, you could use this tool to circle an object on the 
page. Double-clicking this tool allows you to choose the ink color 
and stroke width.  

Highlighter 

 

Just like a physical highlighter, you can use this tool to highlight 
interesting bits of text on a page. Double-clicking this tool allows 
you to choose the highlighter color and stroke width. 

Eraser 

 

This tool is used to remove individual ink or highlighter marks 
that have been added to the current page. 
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Add a Typed 
Note  

Using this tool you are able to add text notes to web pages. These 
notes appear in their own text area.  

Clip 

 

This tool allows you to take a screenshot of a specific portion of 
the current web page. When this tool is selected, a semi-
transparent mask will appear. By clicking and dragging over this 
mask to create a rectangular shape, you can choose exactly what 
you would like to capture.  

 
To start adding annotations to a page, first select a tool. For example, here the Pen tool has 
been selected: 
 

 
 
With the Pen tool selected, you can then click and drag on the page to add marks:  
 

 
 

The Highlighter tool operates in a similar manner. Select this tool and then click and drag 
over the text that you would like to highlight:  
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If you would like to remove highlighter or ink marks, you can use the Eraser tool. Once 
selected, it will remove continuous strokes with one click. For example, if you were to click 
on the highlighter marks that we just added, that entire mark will be removed:  
 

 
 

You can remove all highlighter and ink notes from the current page by double-clicking the 
Eraser tool and then clicking the “Clear all ink” option. 

 
To add typed notes, first select that tool and then click the area where you would like the 
note to be added. This action will display a container in which you can type the note:  
 

 
 

This container will always remain open to display the note. Clicking the garbage can icon in 
the lower right-hand corner of the container will delete it. Note that you can only click this 
icon while the Typed Note tool is selected.  
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Finally, clicking the Clip tool will place a semi-transparent mask over the current web page:  
 

 
 
Click and drag over the region that you would like to capture a screenshot of:  
 

 
 

A small notification will appear next to the selection to let you know that the image has 
been copied to your computer’s clipboard. You can then paste this image into another 
application.  

 
Saving Web Notes 
To save notes that you have added to a web page, click the Save button on the right side of 
the purple toolbar:  
 

 
 

This will provide you with a menu that you can use to save the current web notes to 
Microsoft OneNote, your favorites, or your Reading List:  
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If you choose to save the web notes that you made to either your favorites or Reading List, 
you will be able to open those notes and the accompanying web page at any time. If you 
choose the OneNote option, you will send those notes to an OneNote notebook.  
 
Stop Taking Web Notes 
Once you have finished recording web notes, click the Exit button at the far-right side of the 
purple toolbar:  
 

 
 

The Microsoft Edge window will then return back to its default appearance: 
 

 
 

SHARING WITH MICROSOFT EDGE 

Microsoft Edge incorporates a sharing feature that you can use to share web pages with 
other people using a variety of different methods. For example, if you found an interesting 
website, you could use the share feature to send that website’s URL to someone using e-
mail or even Facebook or Twitter (if you have those apps installed).  
 
To begin, first display the web page that you would like to share. Next, click the Share icon 
near the upper right-hand corner of the Microsoft Edge window:  
 

 
 

This action will display the Share task pane on the right hand-side of your screen. This is a 
Windows pane, so it will list all the apps that you can use to share the current web page. By 
default you will see the Mail and OneNote apps, but if you have Facebook, Twitter, or other 
social media apps, you may see those listed as well: 
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Clicking on any of the options listed here will launch the associated app in a separate 
window. For example, if you were to click the Mail option, the Mail app will open with a new 
blank message. The URL to the web page in question will be listed in the message body and 
the page name will be in the subject line:  
 

 
 
(Likewise, clicking the OneNote option will give you the option to send a quick note to your 
OneNote notebook.) 
 
If you would rather share just a screenshot of the 
web page, click the title of the page in the Share 
pane and click Screenshot:  
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USING CORTANA IN MICROSOFT EDGE 

Cortana is fully integrated into Microsoft Edge. If you have enabled Cortana, you will be able 
to use this feature by typing a simple question into the address bar. For example, if you type 
in “Who founded Microsoft,” Cortana will provide you with an answer directly in the search 
suggestion drop-down menu. This allows you to get quick answers to questions without 
leaving the page that you are on: 
 

 
 

You can also ask Cortana about the content of a page without having to leave the page or 
make a new tab. After selecting a word or phrase that you would like to know more about, 
right-click the selection and click Ask Cortana:  
 

 
 

Cortana will then open in a pane on the right side of the Microsoft Edge window and display 
information about the selected item. In this case, Cortana responds with the seemingly self-
aware statement “I love it here” and then provides you with some information about 
Windows 10.  
 
Now, suppose that you want to know 
what day of the week July 29th falls 
on. Again, select the text in question, 
right-click it, and then click Ask 
Cortana. She will then return with an 
answer as well as other information 
about the date in question:  
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As a final example, Cortana can also look up the definition of words for you. Suppose you 
are reading an article. You come across the word “streamlined” but you do not know what 
that word means. You could select that word, right-click it, and choose Ask Cortana to 
display a definition:  
 

 
 

 

ACTIVITY 4-2 
Using Microsoft Edge 
 
In order to take advantage of everything that Microsoft Edge has to offer, you would like to 
practice using some of its features. Note that you will need to have previously configured 
Cortana in order to complete some portions of this activity. 
 

1.  To begin, sign into your Windows 10 account. 

  

2.  On the taskbar, click the Microsoft Edge button:  
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3.  Microsoft Edge will open:  
 

 

  

4.  First, you would like to find out where the Microsoft headquarters is located. Type 
“Microsoft headquarters” into the address bar. You will see that Cortana has 
provided an answer in the search suggestions drop-down menu. Click it:  
 

 

  



[183] Microsoft Windows 10 – Part 1 

© All rights reserved.  183 of 311 
 

5.  A Bing search page will be displayed with the summary answer that Cortana told 
you, as well as lots of other information about the subject:  
 

 

  

6.  On the right side of the Bing search results page, you will see some summary 
information about Microsoft. Click the Wikipedia link:  
 

 

  

7.  The Wikipedia entry for Microsoft will now be displayed. Add it to your Reading List 
by clicking the star icon on the far right side of the address bar:  
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8.  On the drop-down menu that appears, click the “Reading list” heading if it isn’t 
selected already: 
 

 

   

9.  With the “Reading list” header chosen, you will see that you have the option to 
change the name of the entry. For this example, click the Add button without 
making any changes: 
 

 

   



[185] Microsoft Windows 10 – Part 1 

© All rights reserved.  185 of 311 
 

10.  The current page will now be entered into the reading list. Review the first few 
paragraphs of the Wikipedia page. When you run across the term “BASIC,” use your 
cursor to select it. Right-click on this selection and click Ask Cortana:  
 

 

   

11.  Cortana will then provide information about this subject, including important dates 
and the people related to it: 
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12.  Click anywhere outside of the Cortana pane to close it. Now, let’s start taking some 
web notes. To begin, click the “Make a Web Note” icon near the upper right-hand 
corner of the Microsoft Edge window:  
 

 

  

13.  You will now see the purple Web Notes toolbar. The Pen tool will be selected by 
default:  
 

 

  

14.  On the Web Notes toolbar, click the Pen tool button. A menu will be provided that 
allows you to choose between colors and stroke size. Click the Red color swatch:  
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15.  Your pen stroke color is now red. In the text of the page, find a mention of the city 
in which Microsoft is headquartered. Click and drag to draw a circle around it:  
 

 

  

16.  Now click the Highlighter tool on the Web Notes toolbar:  
 

 

  

17.  Click and drag along the line of text that mentions who the founders of Microsoft 
are:  
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18.  Now that you know some basic information about Microsoft, you don’t need to 
save these notes. On the Web Notes toolbar, click the Exit button:  
 

 

  

19.  The Web Notes toolbar will now disappear and you will see the default Microsoft 
Edge interface. Type “microsoft.com” into the address bar: 
 

 

  

20.  Press the Enter key on your keyboard. The Microsoft.com website will now be 
displayed: 
 

 

  

21.  Add this page to your Favorites by clicking the star icon on the far right side of the 
address bar:  
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22.  On the drop-down that appears, click the Favorites header: 
 

 

  

23.  The menu will now provide you with options to change the name for this new 
favorite, as well as the folder that you will save it to. For this example, leave these 
settings unchanged and click the Add button:  
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24.  As the current page that you are viewing is a favorite, you will see that the star icon 
is now yellow:  
 

 

   

25.  Click the Hub icon near the upper right-hand corner of the Microsoft Edge window:  
 

 

  

26.  On the menu that appears, click the Reading List icon:  
 

 

  

27.  The Wikipedia page that you added to your Reading List earlier will now be 
displayed. Click this entry: 
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28.  You will now see the Wikipedia page: 
 

 

  

29.  Close Microsoft Edge to complete this exercise.  
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TOPIC C: Manage Tabs 
 
Tabbed browsing allows you to have multiple web pages open at the same time within the 
same window. This is an excellent system that keeps your browsing session better organized 
and is more efficient for your computer. Over the course of this topic, you will learn how to 
manage tabs in Microsoft Edge.  
 
Topic Objectives 
In this topic, you will learn: 
 About tabs  
 How to create new tabs  
 How to switch between tabs  
 How to manage tabs  
 How to close a tab 

 

ABOUT TABS 

Tabbed browsing allows you to have several web pages open at once without having to 
have multiple browser windows open. This system is far easier to use and manage, and it 
has become standard amongst all of the major browsers today – including Microsoft Edge.  
 

CREATING NEW TABS 

You can open a new blank tab using two primary methods. The first is to click the New Tab 
button beside the currently opened tab:  
 

 
 

The other is to simply press Ctrl + T on your keyboard.  
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Hyperlinks can also be used to open new tabs. This is done by right-clicking a hyperlink and 
clicking “Open in new tab:” 
 

 
 

When you choose to create a new blank tab, it will automatically be displayed and show 
your frequently visited websites as well as popular sites: 
 

 
 
You may click on one of the links that are provided, enter a URL into the provided address 
bar, or type keywords into the address bar and execute a search using Bing.  
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SWITCHING BETWEEN TABS 

The most straightforward method to switch between open tabs is to click on the tab that 
you would like to view. The tab that is currently active will be identified by a lighter 
background color. For example, here you can see that the Wikipedia tab is currently active 
while the Bing tab is not:  
 

 
 
An even quicker method to switch between tabs is to press Ctrl + Tab on your keyboard. 
This keyboard shortcut will cycle through all the open tabs one at a time. You may need to 
use it multiple times to switch to the tab that you want.  
 

MANAGING TABS 

As the number of tabs that you are using grows, the ability to manage them is important. 
Microsoft Edge offers you a number of different solutions to help keep your tabs under 
control. You can find most of them by right-clicking on an existing tab:  
 

 
 

Let’s break down these options:  
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 Reopen closed tab: This option is useful if you accidentally closed a tab that you 
previously had displayed. Clicking it will immediately restore that tab and its history.  

 Close other tabs: Clicking this option will close all of the tabs that currently exist, 
with the exception of the one that you right-clicked on.  

 Close tabs to the right: This option will close all tabs to the right of the tab that you 
right-clicked on.  

 Refresh all tabs: This option will refresh all the tabs that are currently open. This is a 
great way to ensure that all of the pages that are currently displayed in different tabs 
are up to date.  

 Duplicate tab: Clicking this option will create a duplicate of the tab that you right-
clicked on.  

 Move to a new window: This option will take the tab that you right-clicked on and 
move it to its own separate Microsoft Edge window.  

 
Aside from the right-click options, you can also reorganize the order of open tabs by clicking 
and dragging them into place:  
 

 
 

If you click and drag a tab outside of the current Microsoft Edge window, it will be given its 
own separate window.  
 

CLOSING A TAB 

You may close a tab by clicking the small X on the right-hand side of each tab:  
 

 
 
Alternatively, you can also use the Ctrl + W keyboard shortcut to close the currently active 
tab.  
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ACTIVITY 4-3 
Working with Tabs 
 
As tabs are a very important feature in any web browser, you would like to learn how to use 
them effectively in Microsoft Edge.  
 

1.  To begin, sign into your Windows 10 account and open Microsoft Edge:  
 

 

  

2.  Inside the address bar, type “wikipedia.org” and press Enter:  
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3.  The Wikipedia home page will now be displayed in the current tab:  
 

 

  

4.  Type “Lynx” into the search text box on this page and press the Enter key on your 
keyboard:  
 

 
 

(Note the suggestions that this search box shows you.) 
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5.  The Wikipedia entry for Lynx will now be shown. Scan through the first paragraph 
of this entry and find the hyperlink for “cats.” Right-click this hyperlink and click 
“Open in new tab:”  
 

 

   

6.  A new tab will be created and open to the link that you interacted with; however, 
the Lynx page will still be displayed. Press Ctrl + Tab to switch to the new tab:  
 

 

   

7.  Create a new blank tab by clicking the “New tab” button:  
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8.  A new tab will be displayed with your frequently visited and featured websites. 
Switch back to the Lynx tab by clicking on it:  
 

 

   

9.  The Lynx Wikipedia page will be displayed once again. Right-click on the current tab 
and click “Close other tabs:”  
 

 

   

10.  Now only the current tab will be displayed:  
 

 

  

11.  Close Microsoft Edge to complete this exercise. 
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TOPIC D: Modify Microsoft 
Edge Options 
 
Microsoft Edge includes many different options and settings that you can use to tailor your 
experience with it. Over the course of this topic, you will learn about many of these settings 
and how to change them to suit your needs.  
 
Topic Objectives 
In this topic, you will learn: 
 About the More Actions menu 
 How to customize basic and advanced browser settings 

 

ABOUT THE MORE ACTIONS MENU 

To display the More Actions menu, click the More Actions icon in the top right-hand corner 
of the Microsoft Edge window:  
 

 
 

This menu provides access to a variety of different features and settings that you can use to 
change how you experience Microsoft Edge: 
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The top section of this menu is comprised of two options: 
 New window: Clicking this option will create a new separate Microsoft Edge 

window. You can also complete this action by pressing Ctrl + N on your keyboard.  
 New InPrivate window: When clicked, this option will also create a new separate 

Microsoft Edge window; however, it will use the InPrivate setting. This means that 
your browsing data (like page history, cookies, and temporary files) are not saved at 
the end of a browsing session and are instead discarded. Such windows are 
identified by a blue icon: 

 

 
 
The next section in this menu includes only one option:  
 Zoom: Consisting of two commands (+ and -), this feature is able to adjust the 

magnification level that Microsoft Edge uses. By default this is set to 100%, but you 
can increase it to make elements on a page bigger by clicking the + button. Or, 
decrease the zoom level and make items smaller by clicking the – button:  

 

 
 

The lower section of the More Actions menu provides access to several different settings 
and features:  
 Find on page: Clicking this option toggles the Find bar, which appears just below the 

address bar in Microsoft Edge:  
 

 
 
Using this bar, you are able to search the current web page for particular keywords.  

 Print: This will display the Print dialog box, which you can then use to preview and 
print the currently displayed web page. 

 Pin to Start: If you click this option, a tile will be added to the Start menu that will 
automatically open the current page in Microsoft Edge.  

 F12 Developer Tools: Display the F12 Developer Tools app, which is used to examine 
and work with the underlying code that powers each website.  

 Open with Internet Explorer: This option will open the current page in Internet 
Explorer. This is useful if the page that you are using incorporates a web application 
that can only be operated when opened with Internet Explorer.  

 Send feedback: With this command, you are able to submit feedback to Microsoft 
about Microsoft Edge, including any trouble that you may encounter.  

 Settings: Displays the Settings pane.  
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CUSTOMIZING BROWSER SETTINGS 

The Settings pane includes all sorts of different controls that you can use to customize 
different aspects of the Microsoft Edge experience. To access this pane, click More Actions 
→ Settings:  
 

 
 

When open, the Settings pane is displayed along the right side of the Microsoft Edge 
window:  
 

 
 

From top to bottom, let’s take a look at these settings:  
 Choose a theme: You can use the first drop-down menu to choose between the 

default Light theme and the Dark theme as seen here:  
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 Show the Favorites bar: Below the theme settings, you will see the toggle to turn 

the Favorites bar on or off. (This bar will display quick links to any favorites stored in 
the Favorites Bar folder.) Here you can see it turned on:  
 

 
 

 Open with: This section has several radio buttons that are used to choose which 
page is displayed when Microsoft Edge is first opened. By default this will be the 
Start page; however, you can change this to the new tab page, previous pages, or a 
specific web page. 

 Open new tabs with: Using this drop-down menu you can choose what is displayed 
on a new tab. By default your top sites will be displayed, but you have the option to 
change this to your top sites and suggested content or simply a blank page.  

 Clear browsing data: Clicking the button in this section gives you the option to 
choose what kind of data you would like to remove. For example, you can choose to 
delete your history, cookies, cached data, and much more.  

 
If you scroll down a little more in the pane, you will see the 
following options:  
 Reading: This section includes two drop-down 

menus. The first allows you to choose between the 
default reading style and the light, medium, and dark 
background settings. The second allows you to 
control the font size that Reading view uses.  

 Advanced settings: Clicking the button in this section 
will display the Advanced Settings pane.  
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CUSTOMIZING ADVANCED SETTINGS 

To modify some of the more technical settings that Microsoft Edge has to offer, you need to 
open the Advanced Settings pane. To do this, click More Actions → Settings. Then, scroll to 
the bottom of the Settings pane and click the “View advanced settings” button:  
 

 
 

When open, the Advanced Settings pane will be displayed along the right-hand side of the 
Microsoft Edge window:  
 

 
 
From top to bottom, let’s look at these settings:  
 Show the home button: This option is toggled off by default. When this option is 

toggled on, the Home button will be displayed on the toolbar:  
 

 
 

If this option is toggled on, a drop-down menu will be provided directly under this 
toggle, which you can use to set a new home page.  

 Block pop-ups: This option is toggled on by default and will block pop-ups from 
being displayed.  

 Use Adobe Flash Player: Also toggled on by default, this option enables and disables 
Adobe Flash Player.  
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 Always use caret browsing: Caret browsing is disabled by default, but you can 
enable it using this switch. This feature allows a user to move around a web page 
and highlight selections with the keyboard rather than a mouse. 

 Offer to save passwords: By default, Microsoft Edge will ask you if you would like to 
save your password each time you enter it into a website login page. This switch will 
disable this feature. Also note the “Manage my saved passwords” link, which allows 
you to manage any passwords that you previously saved.  

 
If you scroll down a little more in the pane you will see the following options:  
 

 
 
Let’s review each option. 
 Save form entries: When signing up with websites or purchasing items over the web, 

you will often be asked to fill out forms that include your basic information. This 
feature allows you to save this information so that the next time you need to fill out 
a form, Edge will automatically do it for you. By default this feature is enabled.  

 Send Do Not Track requests: Disabled by default, this feature will tell websites that 
you do not wish to be tracked by their advertising networks. 

 Have Cortana assist me in Microsoft Edge: If you are having trouble getting Cortana 
to work with Microsoft Edge, this toggle is the first thing that you should check. It 
will enable or disable Cortana integration.  

 Search in the address bar with: By default, any search terms that you enter into the 
address bar will be sent to the Bing search engine. Using this drop-down menu, you 
can add another search provider to use instead.  
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 Show search suggestions as I type: This toggle controls whether you see search 
suggestions as you type within the address bar or a search text box. It is enabled by 
default.  

 Cookies: This drop-down menu gives you control over how Microsoft Edge collects 
cookies. By default no cookies are blocked, but you have the option to disable 
cookies sent by third parties or disable them entirely. Note that if you disable 
cookies, you may lose some functionality on some websites.  

 Let sites save protected media licenses on my device: If you purchase a license to 
view a movie or other media from an online provider, this toggle allows those 
providers to save this license to Microsoft Edge. This option is enabled by default.  

 
Finally, at the bottom of the Advanced Settings pane, you will find the following options:  
 

 
These settings are as follows: 
 Use page prediction to speed up browsing, improve reading, and make my overall 

experience better: Microsoft Edge uses page prediction to predict the pages that 
you will go to next and load them ahead of time in the background. This can 
potentially make moving to the next page in a website almost instantaneous. Keep in 
mind that when this feature is enabled, your browsing data is sent anonymously to 
Microsoft to facilitate this process. This feature is enabled by default. 

 Help protect me from malicious sites and downloads with SmartScreen Filter: The 
SmartScreen Filter is a feature that will detect phishing websites (fake websites that 
attempt to steal your credentials) and other harmful items, such as malware. By 
default this feature is enabled and generally should not be modified.  
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ACTIVITY 4-4 
Modifying Microsoft Edge Settings 
 
You would like to customize Microsoft Edge in different ways. To do this, you will need to 
navigate through its different settings.  
 

  To begin, sign into your Windows 10 account and open Microsoft Edge:  
 

 

  

2.  Inside the address bar, type “microsoft.com.” Press Enter to navigate to that 
website:  
 

 

  



[208]  Microsoft Windows 10 – Part 1 

© All rights reserved.  208 of 311 
       

3.  Near the upper right-hand corner of the Microsoft Edge window, click the “More 
actions” button:  
 

 

  

4.  On the menu that appears, click “Pin to Start:”  
 

 

5.  Click the Start button on the taskbar and scroll to the bottom of the Start menu. 
There you will see a tile representing the current page (Microsoft.com in this case): 
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6.  Return to the Microsoft Edge window and click the “More actions” button once 
again. Click Settings: 
 

 

   

7.  So that this pane won’t hide itself automatically, click the pushpin icon in its upper 
right-hand corner to pin it:  
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8.  With the Settings pane now pinned, the content area of Microsoft Edge will 
automatically resize:  
 

 

   

9.  Try out the dark theme by clicking Choose a theme → Dark:  
 

 

   

10.  The Microsoft Edge window will now appear black with white text and section lines:  
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11.  Use the same drop-down menu to change the theme back to Light. Next, click the 
“Show the favorites bar” toggle:  
 

 

  

12.  Below the address bar, you will now see the Favorites bar and any favorites that are 
stored within it:  
 

 

  

13.  Scroll down in the Settings pane and click the “View advanced settings” button:  
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14.  Now the advanced settings for 
Microsoft Edge will be displayed. 
Click the “Show the home button” 
toggle:  
 

 

15.  A text box is now displayed below the toggle 
in which you can enter a URL for your home 
page. Replace the existing text with 
“bing.com” and then click Save:  
 

 

16.  Beside the Refresh button, click the now visible Home button: 
 

 

17.  The URL that you just entered will now be displayed:  
 

 

18.  Close Microsoft Edge to complete this exercise.  

Summary 
Over the course of this lesson you learned all about Microsoft Edge, the new default 
browser for Windows 10. You should now feel comfortable navigating the Microsoft Edge 
interface, as well as using it and its many features to browse the web. Additionally, you 
should now be able to work with tabs, as well as modify Microsoft Edge to your liking.  
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LESSON 5: 
CUSTOMIZING THE WINDOWS 
10 ENVIRONMENT 

 
 
 

Lesson Objectives 
 

In this lesson you will learn how to: 

 Change basic Windows settings 

 Customize the Lock screen 

 Customize the desktop 
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TOPIC A: Change Basic 
Windows Settings 
 
Windows 10 includes many different settings that you can customize to make Windows act 
and appear exactly the way that you want it to. Over the course of this topic, you will learn 
about the two primary locations in Windows 10 where you can find most of these settings: 
the Settings window and the Control Panel.  
 
Topic Objectives 
In this topic, you will learn: 
 How to open and use the Settings window  
 How to access the Control Panel  
 About the categories in the Control Panel 
 How to change the display of the Control Panel 

 

ACCESSING THE SETTINGS WINDOW 

The Settings window serves as a central hub for most of your computer’s basic settings. For 
example, this window will provide you with access to settings to modify your account, but it 
won’t overwhelm you with lots of technical options.  
 
To open the Settings window, click the Settings option within the Start menu: 
 

 
 
You can also access this window by clicking the 
“All settings” button at the bottom of the Action 
Center as shown on the right: 
 
You could also click the Open Settings button on 
the Computer tab of File Explorer when This PC is 
selected: 
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OVERVIEW OF THE SETTINGS WINDOW 

When it opens, you will see that the Settings window is divided into nine categories. Clicking 
on any of these categories will display settings that relate to that category. If you wish to 
find a particular setting, but do not know what category it falls under, you can type search 
terms into the provided search field:  
 

 
 
Let’s examine the types of settings that can be found in each category.  
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System 

 
 
The System category includes many different settings that allow you to control the basic 
underlying operation of Windows 10. This includes things like display settings, notification 
settings, multitasking functions, power and sleep settings, and more. Additionally, you can 
find some basic information about your computer in the About sub-category:  
 

 
 
You can also view how much storage space is being used and how much space is available 
by clicking the Storage sub-category:  
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Devices  

 
 
The Devices category is used to manage any external devices that are connected to your 
computer. For example, you can add and configure printers and scanners, as well as modify 
mouse and keyboard settings. To view a list of devices that are connected to your computer, 
click the “Connected devices” sub-category:  
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The AutoPlay sub-category includes options that let you configure what happens when a 
removable drive or memory card is connected to your computer. For example, you can have 
AutoPlay play media automatically, view the files on the device, take no action, or prompt 
you to choose an action each time:  
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Network & Internet 

 
 
The Network & Internet category is used to configure and manage any network or Internet 
connections that your computer may support. It includes different subcategories based on 
the type of hardware that your PC uses. For example, in this example the computer being 
used does not have a wireless card, so the Wi-Fi sub-category is missing.  
 
The available subcategories allow you to view your Internet data usage from the past 30 
days, configure a VPN (Virtual Private Network), configure a dial-up connection, set up and 
manage Wi-Fi connections, set up and manage Ethernet (wired) connections, and configure 
a proxy.  
 
Personalization  

 
 
In the Personalization category you will find subcategories that allow you to modify the 
background for your desktop, change the accent colors, modify the Lock screen, view the 
settings for themes, and modify some basic Start menu settings.  
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Accounts 

 
 
The Accounts category includes options to configure your user account (and the accounts of 
others). Here, you can view your account settings, apply a profile picture, modify sign-in 
options, configure access to organizational resources (such as networks and e-mail), add 
new users, and configure how your Windows settings sync with other Windows 10 
computers you may have access to.  
 
Time & Language 

 
 
In this category you will find settings to change the date and time, the time zone, formats, 
country and language settings, as well as speech options that control text-to-speech and 
microphone functions.  
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Ease of Access 

 
 
Most of the controls in this category are used to control accessibility options. For example, 
you can enable the Narrator to read what’s on the screen, configure magnifier settings, 
enable high contrast, configure the caption controls for videos, as well as change the 
keyboard and mouse settings (like cursor size and enabling the onscreen keyboard).  
 
Privacy  

 
 
The Privacy category includes many different subcategories that can be used to configure 
privacy settings for different components of your computer.  
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For example, the Camera sub-category includes toggles to control what apps can access 
your computer’s camera:  
 

 
 
Update & Security 

 
 
Finally, the Update & Security category includes many of the controls that you need to 
configure various security settings around Windows 10. For example, the Windows Update 
sub-category lets you check for new updates and security patches. Using the other 
subcategories you can configure Windows Defender, backup settings, Windows 10 recovery 
settings, and view activation information.  
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ACCESSING THE CONTROL PANEL 

While the Settings window includes many different settings to configure your computer, 
there are some settings that can only be found in the Control Panel. The Control Panel has 
long been a part of Windows and acts as a central hub to modify a huge number of settings. 
While future versions of Windows may eventually eliminate the Control Panel in favor of the 
Settings window, you can still access it in Windows 10.  
 
To open the Control Panel in Windows 10, there are few different methods that you can 
use. The quickest method is to right-click the Start button and click Control Panel:  
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You can also click the Control Panel listing within the Windows System folder in the All Apps 
view of the Start menu:  
 

 
 

You could also simply type “Control Panel” into the search 
box on the taskbar and click on the top result: 
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OVERVIEW OF THE CONTROL PANEL 

When the Control Panel is displayed, you will notice that it contains many of the same 
options that are found in the Settings window:  
 

 
 
Also like the Settings window, you will see that it organizes settings into categories; 
however, under each category name you will also see some of its more commonly used 
settings. Clicking one of these options will open that setting or applet directly.  
 
If you are unsure what category contains a specific setting, you can use the provided search 
box to find what you are looking for:  
 

 
 

 
Let’s examine what types of settings you can find in each category:  
 
System and Security 
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This category gives you access to settings that affect the general operation and security of 
your computer. You will find links to Security and Maintenance, Windows Firewall, System, 
Power Options, File History, Backup and Restore, BitLocker, Storage Spaces, Work Folders, 
Administrative Tools, and Flash Player settings.  
 
Network and Internet 

 
 
This category includes access to all of the settings that you need to set up, configure, and 
manage connections between your computer and a network or the Internet. It includes links 
to the Network and Sharing Center, HomeGroup, and Internet Options.  
 
Hardware and Sound  

 
 
This category gives you access to settings that are used to manage how your computer’s 
hardware operates, as well as configure its sound options. Included are links to Devices and 
Printers, AutoPlay, Sound, Power Options, and Display.  
 
Programs  
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This category will allow you to manage any programs that you have installed on your 
computer. For example, if you wanted to remove a program, this is the category you would 
choose. This includes accessing Programs and Features, as well as Default Programs.  
 
User Accounts  

 
 
This category is used to create, manage, and modify user accounts in Windows 10. Included 
in this category are links to User Accounts and the Credential Manager. If you have an e-mail 
program like Microsoft Outlook installed, you may also see a Mail icon which will allow you 
to configure that application.  
 
Appearance and Personalization  

 
 
This is the category that you need to access if you would like to modify the appearance of 
Windows 10. Included are links to Personalization, Display, Taskbar and Navigation, the Ease 
of Access Center, File Explorer Options, and Fonts.  
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Clock, Language, and Region  

 
 

In this category you will find links to change your system’s clock, language, and region 
settings. Included are links to Date and Time, Language, and Region. As these settings are 
important to the operation of many apps, it is a good idea to make sure that they are 
correct.  
 
Ease of Access 

 
 
Finally, this category provides you with access to settings that provide accessibility 
enhancements to your computer. For example, using this category you can turn on speech 
narration. Included in this category are links to the Ease of Access Center and Speech 
Recognition.  
 

CHANGING THE CONTROL PANEL VIEW 

While the Control Panel is organized into categories by default, you can also view an 
alphabetical list of the primary settings that are available. To do this, click the “View by” 
drop-down menu near the top right-hand corner of the Control Panel window and click 
either the “Large icons” or “Small icons” options:  
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For example, here you can see the Control Panel viewed using the Small Icons setting:  
 

 
 
 

ACTIVITY 5-1 
Customizing Your Computer’s Settings 
 
You would like to become familiar with the different ways that you can view and work with 
many of your computer’s different settings.  
 

1.  To begin, sign into Windows 10.  

  

2.  Open the Settings window by clicking the Start button and then clicking the 
Settings option:  
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3.  The Settings window will now be open on your desktop: 
 

 

  

4.  Click the Accounts category:  
 

 

  

5.  With the Accounts category now displayed, you will see information about your 
current Windows 10 accounts. Additionally, you will see a variety of different 
settings that can be used to modify or manage your account:  
 

 



[231] Microsoft Windows 10 – Part 1 

© All rights reserved.  231 of 311 
 

6.  Click the “Sign-in options” sub-category:  
 

 

  

7.  You will now see settings for the various sign-in options that are available to you:  
 

 
 
(Your settings may be different depending on what type of account you are using.) 

   

8.  Return to the Settings home screen by clicking the Back button in the upper left-
hand corner of the window:  
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9.  The Settings window will once again list its categories. Inside the search field, type 
“display:”  
 

 

   

10.  A list of settings that include “display” in the name will now be listed. Click the 
“Display settings” option:  
 

 

   

11.  The System category will now be open to the Display sub-category:  
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12.  Close the Settings window by clicking the Close button in its upper right-hand 
corner:  
 

 

  

13.  Open the Control Panel by right-clicking the Start button and clicking Control Panel 
on the context menu:  
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14.  The Control Panel window will now be displayed on your desktop:  
 

 

  

15.  Click the “System and Security” category header:  
 

 

  

16.  The “System and Security” category will now be open and list many different links:  
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17.  Click the System link header:  
 

 

  

18.  Information about your computer will now be displayed:  
 

 

  

19.  Return to the Control Panel home by clicking the Control Panel Home link near the 
upper left-hand corner of this window:  
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20.  The main screen of the Control Panel will now be 
displayed. Change the view by clicking the “View 
by” drop-down menu and then clicking the “Large 
icons” option:  
 

 

21.  An alphabetized list of primary settings will now be shown:  
 

 

22.  Apply the category view by clicking the “View by” drop-down menu once again and 
clicking the Category option:  
 

 

23.  Click the Close button in the upper right-hand corner of the Control Panel to 
complete this exercise.  
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TOPIC B: Customize the Lock 
Screen 
 
As you now know, the Lock screen is the first screen that is displayed when your computer 
starts or when you wake it up. In addition to a background image and the current date and 
time, you will also see glyphs that depict network status, power levels, and other 
information. Over the course of this topic, you will learn how to customize this screen.  
 
Topic Objectives 
In this topic, you will learn: 
 How to use the Lock screen 
 How to change the Lock screen background  
 How to change what apps appear on the Lock screen  
 How to change the screen saver 

 

USING THE LOCK SCREEN 

The Lock screen has been designed to display the current date and time, as well as a 
background picture of your choosing. Additionally, you can choose to include basic 
information from specified apps. For example, here you can see some detailed weather 
information and that there is one unread e-mail message:  
 

 
 
Aside from information gathered from a selection of apps, you will also see glyphs that 
convey information about various aspects of your PC. For example, you will 
see network connectivity information in the lower right-hand corner of the 
Lock screen. In this example, the computer is connected to a network using a 
cable (icon shown on the right). 
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If it were connected to a wireless connection, you would instead see the Wi-Fi symbol. If 
you are using a notebook computer, you will also see information about your PC’s battery.  
 

CHANGING THE BACKGROUND 

To change the background of the Lock screen, first open the Settings window (Start → 
Settings), and then click the Personalization category: 
 

 
 

Click the “Lock screen” sub-category: 
 

 
 

All the settings that control the Lock screen will now be displayed:  
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A preview of the current Lock screen will be displayed with a series of thumbnail images 
below it. Click on any of these thumbnails to apply them or click the Browse button to find 
an image on your computer. After you choose a new background image, it will be reflected 
in the preview:  
 

 
 

If you wish to have a rotation of pictures on your Lock screen, you can click the Background 
drop-down menu and click Slideshow:  
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When the Slideshow option is selected, you will then need to select the folder in which the 
slideshow pictures are stored: 

 

 
 

You will also be given access to some advanced slideshow settings that allow you to control 
how the slideshow behaves in conjunction with power settings, as well as other options. 
 

CHANGING APPS 

Status information from some of the apps that you have installed on your computer can be 
shown on the Lock screen in two different levels of detail: detailed and quick status.  
 
As the name implies, the detailed status level will show a line or two of information from a 
single app. (By default the Calendar app is selected, but you can change it whichever 
compatible app you would like.)  
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The quick status level will only give you the very basic status information about an app, like 
the number of unread e-mails in the Mail app. You may have up to seven apps showing a 
quick status on the Lock screen.  
 
To change what apps appear on the Lock screen, first open the “Lock screen” sub-category 
of the Personalization category in the Settings window. Scroll to the bottom of this sub-
category. Here, you will see a series of icons. The single icon on its own line is used to 
choose which app shows the detailed status, while the line of icons below it is used to 
choose which apps show quick statuses:  
 

 
 

Clicking on a thumbnail allows you to choose from a list of compatible apps that you can add 
to the Lock screen:  
 

 
 

CHANGING THE SCREEN SAVER 

While screen savers have been around for a long time, their original purpose (to prevent 
static images from burning into the screen of a monitor) is rarely a problem anymore. 
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However, they are still available with Windows 10 to add a little visual flair to your 
computer when you are not using it.  
 
By default, Windows 10 does not use a screen saver at all. To change this (or change the 
screen saver that has been previously applied), click the “Screen saver settings” link at the 
bottom of the “Lock screen” sub-category of the Personalization category in the Settings 
window:  
 

 
 

Alternatively, you can also access the same settings by opening the Control Panel, searching 
for “screen saver,” and clicking the “Change screen saver” link:  
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In either case, the Screen Saver Settings dialog will be displayed:  
 

 
 

Clicking the “Screen saver” drop-down menu allows you to choose from a small selection of 
screen savers that are included with Windows 10. Once a screen saver has been selected, 
you can use the Wait increment box to choose when the screen saver is shown, and if you 
want to ask for user credentials when it is interrupted.  
 

ACTIVITY 5-2 
Customizing the Lock Screen 
 
Now that you are growing more comfortable with Windows 10, you would like to learn how 
to make it more your own by choosing a new Lock screen background and customizing 
which apps are displayed.  
 

1.  To begin, log into your Windows 10 account.  

2.  Open the Settings window by clicking Start → Settings:  
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3.  With the Settings window now open, click the Personalization category: 
 

 

4.  Now that the Personalization category is displayed, click the “Lock screen” sub-
category: 
 

 

  

5.  You will now see a preview of the current Lock screen, followed by a number of 
different settings:  
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6.  In the “Choose your picture” section, click a different thumbnail to apply it as a 
background picture:  
 

 

7.  The preview will update and show you how the Lock screen will look with the new 
background picture:  
 

 

8.  Scroll down in the window. You will see a series of icons that are used to choose 
which apps appear on the Lock screen. Under the “Choose an app to show detailed 
status” header, you will see the Calendar icon by default. Click it:  
 

 
 

(If you see a different icon, you can still click it to display the same menu shown in 
the next step.) 
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9.  A list of apps that are compatible with this feature will be shown. Click the Weather 
option:  
 

 

   

10.  The Weather icon will now be shown under this header:  
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11.  Close the Settings window and click Start → [Your Username] → Lock:  
 

 

  

12.  You will now see your newly customized Lock screen that includes a new 
background picture and weather details for your area:  
 

 
 

This exercise is now complete. 
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TOPIC C: Customize the 
Desktop 
 
Just like with previous versions, Windows 10 allows you to customize the desktop by 
changing the background, color scheme, and theme. In this topic, you will learn how to 
customize the desktop. 
 
Topic Objectives 
In this topic, you will learn: 
 How to change the desktop background  
 How to change the accent color 
 How to apply a theme  

 

CHANGING THE DESKTOP BACKGROUND 

Just like you can change the background picture of the Lock screen, you can also change the 
background picture that appears on the desktop. To do this, open the Personalization 
category of the Settings window and ensure that the Background sub-category is displayed: 
 

 
 

A preview of the current desktop will be displayed with a series of thumbnails listed below 
it. Click on any of these thumbnails to apply the related image or click the Browse button to 
find an image on your computer. Once you choose a new background image, this change 
will be reflected in the preview:  
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Once a picture has been applied, you can use the “Choose a fit” drop-down menu to choose 
how the image is positioned on your screen:  
 

 
 
The options include:  
 Fill: The selected picture will fill up your entire screen, but some of it may be 

cropped. 
 Fit: The selected picture will re-sized to fit your screen horizontally, but blank areas 

may appear above or below it. 
 Stretch: The selected picture will be stretched to fit your screen from top to bottom, 

but it may appear distorted.  
 Tile: The selected picture will be tiled across your screen evenly using its default size. 
 Center: The selected picture will be centered using its default size, but blank areas 

may appear around it.  
 Span: The selected picture will be stretched to fit two or more monitors that are 

connected to your computer. Ensure that the selected picture is wide enough for this 
purpose. 
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If you wish to have a steady rotation of desktop backgrounds so that the same image is not 
always displayed, you can click the Background drop-down menu and click Slideshow:  
 

 
 

When the Slideshow option is selected, you will then need to select the folder in which the 
pictures to include in the slideshow are stored. Additionally, you can choose how often the 
picture is changed: 
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Alternatively, you can click the “Solid color” option under 
the Background drop-down menu. This option will allow 
you to choose from a variety of solid colors that you can 
use as a background: 
 

 
 
 

CHANGING THE ACCENT COLOR 

To change the accent colors that Windows 10 uses for 
borders, tiles, icons, and tabs, first open the Colors sub-
category of the Personalization category of the Settings window:  
 

 
 

Like the other subcategories, you will see a preview of how the desktop looks with the 
current settings.  
 
Below the preview you will see a toggle that can be used to source the accent colors from 
background picture. (For example, if your background includes lots of red, a shade of red 
will be used for accents.) Below this, you will see a grid of color swatches that you can use to 
manually pick an accent color:  
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Below the color selection options, you will see a switch that is disabled by default. When 
enabled, it will show color on the Start menu, taskbar, and Action Center. For example, here 
you can see how the Start menu looks with this option enabled while a shade of blue is the 
accent color:  
 

 
 

Below this toggle you will see another option that you can use to make the Start menu, 
taskbar, and Action Center transparent. Finally, the “High contrast settings” link will display 
the “High contrast” sub-category of the Ease of Access category in the Settings window.  
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APPLYING A THEME 

Themes are used to apply a consistent look and feel throughout the Windows environment. 
For example, a theme can change the background picture, accent color, and taskbar 
transparency settings all at one time. To apply a new theme, first open the Personalization 
category in the Control Panel. This is can be done by clicking the “Theme settings” link 
within the Themes sub-category of the Personalization category in the Settings window:  
 

 
 

Or, simply go through the Control Panel directly:  
 

 
 

When open, you will see that the Personalization window includes a gallery of default 
themes that you can choose from: 
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To apply a new theme, click on the theme in question. It will immediately be applied.  
 

ACTIVITY 5-3 
Customizing the Desktop 
 
You would like to see the various different ways that you can customize the desktop and 
make it your own. 
 

1.  To begin, log into your Windows 10 account. 

  

2.  Open the Settings window by clicking Start → Settings:  
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3.  With the Settings window now open, click the Personalization category:  
 

 

  

4.  With the Personalization category now open, you should see the Background sub-
category displayed. If not, select it:  
 

 

  

5.  Apply a different background picture for your desktop by clicking one of the 
thumbnails that are presented:  
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6.  The preview of your desktop will change to incorporate the new background 
picture:  
 

 

7.  Click the Colors sub-category:  
 

 

8.  You would like the accent color to match the new picture that you selected. Click 
the “Automatically pick an accent color from my background” switch so it is in the 
On position: 
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9.  All of the accent colors in Windows 10 will now match the new background. In this 
example you can see that the accent color is now a light blue:  
 

 

   

10.  Close the Settings window to complete this exercise.  

 
 

Summary 
Over the course of this lesson you learned about the various ways that you can customize 
Windows 10. You should now know where you can access Windows settings, and you should 
be familiar with what settings are available. Additionally, you should now know how to 
customize both your Lock screen and your desktop in a number of different ways. 
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LESSON 6: 
USING WINDOWS 10 
SECURITY FEATURES 

 
 
 

Lesson Objectives 
 

In this lesson you will learn how to: 

 Configure passwords 

 Use Windows Defender 

 Store and share files with OneDrive 
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TOPIC A: Configure Passwords 
 
The password to your Windows 10 account is an important thing to consider. While it 
should be memorable, it should not be easy for others to guess. Aside from the standard 
alphanumeric password, you also have the option to add PIN and/or picture passwords so 
that you don’t always have to type out a complicated password. Over the course of this 
topic, you will learn about the different types of passwords that Windows 10 has to offer 
you. 
 
Topic Objectives 
In this topic, you will learn: 
 About passwords  
 How to add a PIN password 
 How to add a picture password 

 

MANAGING PASSWORDS 

Your Windows 10 account password is used for everything from logging into your account to 
buying apps and completing certain operations. You can change this password at any time 
by first opening the Settings window (Start → Settings), and then clicking the Accounts 
category: 
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With the Accounts category displayed, click the “Sign-in options” sub-category:  
 

 
 

This sub-category includes several different settings that relate to your password. (You may 
see different options depending on what type of account you are using.)  
 
At the top, you will see the “Require sign-in” drop-down menu. This allows you to choose if 
you would like to have Windows require your password if your PC is woken up or remove 
that requirement entirely. To change your password, click the Change button under the 
Password category: 

 

 
A pop-up dialog box will appear in which you need to enter your password to proceed: 
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Once you enter your password and click Next, you will be prompted to enter your new 
password twice, as well as a hint: 
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Click the Next button once you have 
filled in the information. You will see a 
confirmation dialog box: 
 
Click Finish to complete the process. 
 

 

 

 

 

 

ADDING A PIN PASSWORD 

PIN passwords are simple numeric passwords that can be used in place of a regular 
password. The idea behind this is that you can much more easily log into your Windows 
device without having to type in a long password string. 
 
To create a PIN password, first open the “Sign-in options” sub-category of the Accounts 
category of the Settings window. Next, click the Add button under the PIN header: 
 

 
 

A pop-up will then ask you to enter your current password. Do so, and then you will be 
asked to enter and re-enter a PIN that you can use to access your account:  
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Once a PIN has been added, you can change it by clicking the appropriate Change button in 
the “Sign-in options” sub-category: 

 

 
 

ADDING A PICTURE PASSWORD 

Picture passwords are similar to a PIN in that they offer you a simplified way to log into your 
account. Instead of having to type in your password, you recreate mouse gestures on a 
picture that you previously set up.   
 
To add a picture password, click the Add button under the “Picture password” header:  
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First you will need to enter your current account’s password. Once that is done, you will be 
presented with the Picture Password screen:  
 

 
 
This screen allows you to choose between using the default picture or a picture of your own. 
In either case, you can position this picture within the frame however you like by clicking 
and dragging. When you are ready to create the picture password, click the “Use this 
picture” button:  
 

 
 
The first stage of the process is to use your mouse to draw (click and drag) three separate 
mouse gestures over the picture. For example, you could circle the runner and draw lines 
that follow the top of the rock formations:  
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(Remember that the direction in which you draw your gestures does matter.) 
 

You will then be asked to repeat those same gestures. As you complete each gesture, the 
number of the gesture that you need to draw is shown. When you’ve successfully repeated 
the gestures, you will receive a confirmation:  
 

 
 
After a picture password has been applied, you will see buttons to change it or remove it 
under the “Picture password” header: 
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ACTIVITY 6-1 
Creating a PIN Password 
 
To help save time when logging into your Windows 10 account, you are going to create a 
simple PIN password.  
 

1.  To begin, log into your Windows 10 account.  

  

2.  Open the Settings window by clicking Start → Settings:  
 

 

  

3.  With the Settings window now open, click the Accounts category: 
 

 

  



[268]  Microsoft Windows 10 – Part 1 

© All rights reserved.  268 of 311 
       

4.  With the Accounts category now displayed, click the “Sign-in options” sub-
category: 
 

 

  

5.  Under the PIN header, click the Add button:  
 

 
 

If this setting is not available, click through each of the sub-categories on the left-
hand side of the Accounts category of the Settings window to complete the 
exercise. 
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6.  A pop-up dialog box will appear in which you need to enter your current password. 
Do so and click “Sign in:” 
 

 

   

7.  The “Set up a PIN” pop-up will now be displayed. Enter the PIN that you would like 
to use into both of the fields. Click OK: 
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8.  With the new PIN now applied, close the Settings window. Press Win + L on your 
keyboard to lock your computer. Move past the Lock screen and you will see a text 
box in which you can enter your PIN:  
 

 

   

9.  Enter your PIN. You will automatically be logged into your Windows 10 account. 
This completes the exercise. 

 
  



[271] Microsoft Windows 10 – Part 1 

© All rights reserved.  271 of 311 
 

TOPIC B: Use Windows 
Defender 
 
While the Internet is an excellent resource and a major component of communication in 
today’s world, it can also be a dangerous place for your computer. Over the course of this 
topic, we will learn about one of the key features that helps protect your computer from 
viruses and malware: Windows Defender.  
 
Topic Objectives 
In this topic, you will learn: 
 About Windows Defender  
 How to open Windows Defender  
 About the Windows Defender interface 
 How to modify Windows Defender settings 

 

WHAT IS WINDOWS DEFENDER? 

Windows 10 includes a built-in antivirus package that is active as soon as you turn on your 
computer called Windows Defender. It is designed to protect your computer from a variety 
of threats found on the Internet. It will scan any files that are downloaded to your computer 
for malicious code. As this app is automated to ensure that it scans for threats on a regular 
basis and will update itself, you typically will not need to interact with it often. However, it is 
important to know how to work with it should the need arise.  
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OPENING WINDOWS DEFENDER 

Windows Defender, unlike other third-party security products, is integrated right into the 
Windows 10 operating system. However, it does have an interface you may use to interact 
with it and its settings. To open Windows Defender using the Start menu, display the “All 
apps” list and click the Windows Defender listing within the Windows System folder: 
 

 
 

(Alternatively, you can type “Windows Defender” into the search field and click on the most 
relevant result.) 
 

OVERVIEW OF WINDOWS DEFENDER 

When Windows Defender is opened, the following interface will be displayed:  
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At the top of this window, you will see a color-coded bar that will indicate the current status 
of your antivirus protection. This bar will be green if no problem has been identified, yellow 
if there is a moderate problem, or red if there is a critical issue.  
 
The main portion of the interface is divided into three tabs: Home, Update, and History. The 
Home tab will be displayed by default. It includes basic information about the current status 
of Windows Defender, including when it was last updated and when it last scanned your PC. 
You will also see controls on this tab to manually start a scan:  
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The Update tab displays detailed information about your virus and spyware definitions:  
 

 
 
Definitions are used to identify threats, so they need to be updated constantly to keep your 
computer protected. This process is automatic by default, but you can start a manual 
update by clicking the Update button. The lower portion of this window will display helpful 
information about Windows Defender and the update process.  
 
The History tab contains links to display items that Windows Defender has previously 
flagged as being potentially harmful for your computer, as well as the action you took:  
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To view the history, you first need to select the “Quarantined items,” “Allowed items,” or 
“All detected items” radio button.  
 Quarantined items will display any items that were prevented from being executed 

but are stored in a secure location.  
 Allowed items will list any items that you’ve chosen to run despite being flagged as a 

possible issue.  
 All detected items will show all items that have been detected.  

 
Once you’ve selected either of these options, click the “View details” button. A box will be 
displayed showing the item types you selected:  
 

 
 
Near the upper right-hand corner of the Windows Defender window, you will also see the 
Settings button:  
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Clicking this button will open the Update & Security category of the Settings window to the 
Windows Defender sub-category. Here, you can find options to control how Windows 
Defender operates:  
 

 
 

CHANGING WINDOWS DEFENDER SETTINGS 

In the Windows Defender sub-category of the Update & Security category on the Settings 
window, you will find all sorts of settings to control how the program works.  
 
Let’s break down each section in this sub-category:  
 

Real-time 
protection 

This section contains only one setting, which is used to toggle 
Windows Defender’s real-time protection on and off. Real-time 
protection alerts you immediately when malicious files are detected 
on your computer and should generally be left on. 

Cloud-based 
protection 

This section contains one setting and a link to Microsoft’s privacy 
statement. This setting is used to control if you want to send 
information to Microsoft about a potential security problem or not.  

Sample submission The setting in this section allows you to toggle the ability for 
Windows Defender to send samples of any malicious items it detects 
to Microsoft to help them learn about it.  

Exclusions This section is used to add files, folders, file types, and file processes 
to the exclusion list. Any items on the exclusion list are not scanned 
by Windows Defender. You would typically add an item to this list if 
it is falsely detected as a threat.  
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Version info In this section you will see a list of version numbers that indicate 
what version each part of Windows Defender has last been updated 
to. Below this information you will see a link to open Windows 
Defender directly.  

 
 

ACTIVITY 6-2 
Using Windows Defender 
 
In order to ensure that your PC is protected, you would like to update Windows Defender 
and run a quick scan.  
 

1.  To begin, log into your Windows 10 account.  

  

2.  Inside the search box on the taskbar, type “Windows Defender” and click the top 
search result:  
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3.  Windows Defender will now be open on your desktop:  
 

 

4.  Click the Update tab:  
 

 

5.  To ensure that Windows Defender is completely up to date, click the Update 
button:  
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6.  Windows Defender will then continue to download and install any updates that it 
might find:  
 

 

7.  When the update process is complete, click the Home tab:  
 

 

8.  Ensure that the Quick radio button is selected and then click the “Scan now” 
button:  
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9.  Windows Defender will now start to scan your PC for any malicious items:  
 

 

   

10.  When the scan is complete, you will see the results: 
 

 

  

11.  Close Windows Defender to complete this exercise. 
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TOPIC C: Store and Share Files 
with OneDrive 
 
Microsoft OneDrive continues to be an important feature in Windows that you can use to 
save, back up, and share files. Over the course of this topic, you will learn about OneDrive 
and how it works in Windows 10.  
 
Topic Objectives 
In this topic, you will learn: 
 About Microsoft OneDrive  
 About the OneDrive notification icon  
 How to view your local OneDrive folder  
 How to view your online OneDrive folder  
 How to upload files and folders to your OneDrive account  
 How to change OneDrive settings 

 

WHAT IS ONEDRIVE? 

Microsoft OneDrive (formerly known as SkyDrive) is an online storage service that can sync 
changes to files between devices and keep them safe while still allowing you to access them 
from anywhere. A OneDrive account is included with every Microsoft account (Outlook, 
Hotmail, Live, etc.) and will automatically be configured if you are using such an account to 
log into Windows.  
 

USING THE ONEDRIVE NOTIFICATION ICON 

As OneDrive has been completely integrated into Windows 10, you will see its components 
scattered throughout it. In particular, if you examine the notification area, you will see a 
OneDrive notification icon:  
 

 
 

(You may need to click the “Show hidden icons” arrow to see it.) 
 
This icon will change to indicate any activity that is happening in your OneDrive account. For 
example, if you added an item to your OneDrive folder, it will change to show a blue circular 
arrow icon in the middle of it as it syncs that change with the online folder:  
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Clicking on this icon will show you when your OneDrive account was last synced, as well as 
provide a link to your local OneDrive folder:  
 

 
 

Right-clicking this icon will open a contextual menu that also includes an option to open 
your OneDrive folder, as well as open your browser to OneDrive.com. You will also be able 
to view the details of any sync problems that you might be having, view how much storage 
space is available to you, access OneDrive settings, find help, and exit OneDrive entirely:  
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VIEWING YOUR LOCAL ONEDRIVE FOLDER 

To view your local OneDrive folder, click the OneDrive listing within the Navigation pane in 
File Explorer:  
 

 
 
(Note that some of the folders in this example are actually folders that exist within the 
OneDrive account. These folders can be identified by the status icon in their lower left-hand 
corners.) 
 
You will then see your OneDrive’s contents just like any folder or drive: 
 

 
 
(You can also expand the OneDrive listing within the Navigation pane so that you can see 
the subfolders there.) 
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VIEWING YOUR ONLINE ONEDRIVE FOLDER 

To view your online OneDrive folder, right-click the OneDrive notification icon and click “Go 
to OneDrive.com:”  
 

 
 

This action will open your default web browser to the OneDrive.com website:  
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Click the “Sign in” button and enter your Microsoft account credentials. You will then be 
presented with a view of your online OneDrive folder:  
 

 
 

Your online OneDrive folder will contain everything that your offline one does; however, 
that might not always be the case the other way around. For example, you can choose to 
have OneDrive sync only specific folders so that it will download some files from your 
account, but not others.  
 

UPLOADING FILES AND FOLDERS  

Anything that you place into your local OneDrive folder (or any of its subfolders) will be 
uploaded to your online OneDrive account automatically. This is a great way to back up files 
to a secure location to ensure that they will not be lost due to a software or hardware crash. 
Additionally, any changes that you make to a file or folder that resides here will 
automatically be synced with any other copies of that item.  
 
For example, suppose that you are working on a presentation stored in your OneDrive 
account using your PC at the office, but you use your laptop to add some finishing touches 
later. If you update that presentation file directly within OneDrive (or copy it over after the 
fact) using your laptop, the newly updated file will be sent to your OneDrive account and 
then propogate to any other computers that you use with OneDrive – including, in this case, 
the PC at your office. This saves you from e-mailing yourself files or copying them using USB 
drives.  
 

CHANGING ONEDRIVE SETTINGS 

To view and change your OneDrive settings, right-click the OneDrive notification icon and 
then click Settings:  
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The Microsoft OneDrive dialog box will then be displayed on your desktop. It is divided into 
five tabs: Settings, Auto Save, Choose Folders, Performance, and About.  
 
The Settings tab will be displayed by default. It includes general settings, like controlling 
when OneDrive starts with Windows 10 and enabling the “Fetch files” feature. If enabled, 
this feature allows you to access all files on your PC from another computer from the 
OneDrive website: 

 

 
 
Also on the Settings tab is the Unlink OneDrive button. Clicking this button will unlink your 
PC from whichever OneDrive account it is currently linked to. You would use this button if 
you wanted to configure your PC with a different OneDrive account.  
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The “Auto save” tab allows you to automatically save data from devices to OneDrive: 
 

 
 
The “Choose folders” tab only contains the “Choose folders” button. If you would like to 
only download and sync specific folders on your OneDrive account with your PC, you would 
click this option:  
 

 
 

When the “Choose folders” button is clicked, you will see a list of the folders in your 
OneDrive account. The folders with a checkmark placed next to them are being synced with 
the current PC. Remove this checkmark to remove the associated folder from your 
computer (but not remove it from OneDrive):  
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The Performance tab includes only the “Improve upload speed by uploading files in 
batches” checkbox. This is checked automatically and will generally help your files upload 
faster. However, it is more bandwidth-intensive, so you may want to consider deselecting 
this option if you have limited bandwidth or are using other bandwidth-intensive services: 

 

 
 

Finally, the About tab includes a series of links to general information about Microsoft 
OneDrive, its current service status, terms of use, and privacy statement. You will also see 
the current version of OneDrive that is installed on your computer: 
 

 
 

ACTIVITY 6-3 
Using OneDrive 
 
You would like to explore the various ways that you can interact with OneDrive on your 
desktop.  
 

1.  To begin, sign into your Windows 10 account. 
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2.  On the taskbar, click the File Explorer icon:  
 

 

  

3.  With the File Explorer window open, click the OneDrive entry in the Navigation 
pane:  
 

 

  

4.  The contents of your local OneDrive folder will now be listed. Note the small sync 
status icon that appears next to each item: 
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5.  Close File Explorer and examine the notification area. If you do not see the 
OneDrive notification icon, expand the notification area by clicking the upward-
pointing arrow:  
 

 
 

(If the OneDrive icon is visible, skip to the next step.) 

   

6.  Click the OneDrive icon to see when it was last updated (synced): 
 

 

   

7.  Now right-click this icon and click Settings:  
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8.  The Microsoft OneDrive 
dialog will now be shown 
on your desktop. Examine 
the Settings tab of this 
dialog box. You will see 
that OneDrive has been 
set to start automatically 
when Windows 10 starts:  
 

 

9.  Click the “Choose folders” tab and then click the “Choose folders” button:  
 

 

10.  A pop-up will display all of the folders that 
exist in your OneDrive account, as well as 
information on how much storage space is 
available to you: 
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11.  Deselect the checkbox that is associated with any folder that you do not need to or 
want to sync with your PC:  
 

 
 

(If you are doing this for the first time, a warning dialog may be displayed. Review 
this information and continue.) 

12.  Click OK to apply the new settings:  
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13.  Back at the Microsoft OneDrive dialog box, click OK: 
 

 

14.  Your changes will now be applied. Sign out of your Windows 10 account to 
complete this exercise. 

 

Summary 
During this lesson you learned about some of the security features that are available to you 
in Windows 10. You should now feel comfortable changing your password, adding a PIN 
password, and creating a picture password. As well, you now know about Windows 
Defender and how to use it to check your computer for malicious items. Finally, you should 
now know about OneDrive, how it works, and how to change its settings. 
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APPENDICES 

Keyboard Shortcut Quick Reference Sheet 
 

W
in

do
w

 M
an

ag
em

en
t 

Minimize the window Win + Down Arrow 

Maximize the window Win + Up Arrow 

Switch to the previous window Alt + Tab 

Snap to the right Win + Right Arrow 

Snap to the left Win + Left Arrow 

Open Task View Win + Tab 

Close the current window Alt + F4 

N
av

ig
at

e 
th

e 
In

te
rf

ac
e 

Display the Start menu Win 

Display the desktop Win + D 

Open the Start button’s context menu Win + X 

Toggle Cortana (speech) Win + Q 

Search Windows and the web Win + S 

Open Windows settings Win + I 

Open the Action Center  Win + A 

Peek at the desktop Win + , 

M
an

ag
e 

Fi
le

s 

Open File Explorer Win + E 

Select all items Ctrl + A 

Copy selected object Ctrl + C 

Cut selected object Ctrl + X 

Paste clipboard contents Ctrl + V 
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Vi
rt

ua
l D

es
kt

op
s Open Task View Win + Tab 

Create new virtual desktop Win + Ctrl + D 

Close current virtual desktop Win + Ctrl + F4 

Switch between virtual desktops Win + Ctrl + Left 
Arrow/Right Arrow 

G
en

er
al

 

Apply bold formatting Ctrl + B 

Apply underlining Ctrl + U 

Apply italic formatting Ctrl + I 

Align text to center Ctrl + E 

Align text to left Ctrl + L 

Align text to right Ctrl + R 

Print Ctrl + P 

Undo last action Ctrl + Z 

Redo last action Ctrl + Y 
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Glossary 
 
app 
Software that is installed on your 
computer to complete a specific task. 
 
boot 
The process that a computer goes through 
when it is first turned on. 
 
clipboard 
Where copied or cut items are 
temporarily stored before they are pasted 
elsewhere. 
 
context menu 
The menu that appears when an item is 
right-clicked. 
 
contextual tab 
Extra tabs that appear on the ribbon of an 
application when a specific object is 
selected. 
 
desktop 
The primary working area in Windows 
where you run applications. 
 
desktop application 
An application that is designed to operate 
on the desktop that is typically more 
complex than an app. 
 
File Explorer 
A built-in application that is used to view 
and manage files and folders on a 
computer. 
 
folder 
An object that is used to store files. 
 
 
 
hardware 

The physical components that make up a 
PC. 
 
jump list 
A menu that appears when you click and 
drag an icon off the taskbar. 
 
library 
A special type of folder that lists related 
files and folders from various locations in 
a single area. 
 
Microsoft Edge 
The new default web browser that is 
included in Windows 10. 
 
notification area 
An area designed to show icons for 
running applications that you can view 
and interact with. 
 
OneDrive 
An online storage solution that allows 
users to store, access, and distribute files. 
 
Recycle Bin 
A directory that is used to temporarily 
store deleted objects. Can be used to 
restore or permanently delete items.  
 
ribbon 
An interface component that organizes 
commands into tabs and groups. 
 
search engine 
An online service that searches the web 
for terms that are entered. 
 
Snap 
A feature that is used to keep open 
windows locked to either side, or in a 
corner, of the computer screen. 
 
Start button 
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Located on the far left-hand side of the 
taskbar. Used to display the Start menu. 
 
Start menu 
Used to find applications and settings, as 
well as view information via tiles. 
 
taskbar 
An interface element that appears along 
the bottom of the screen by default. Will 
display icons for open or pinned apps. 
URL 

Stands for Uniform Resource Locator. A 
unique address that you can follow to a 
resource on the Internet. 
 
web browser 
An application that is used to display 
information from the web. 
 
Windows Defender 
A built-in virus scanner that protects your 
computer from malicious items. 
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